Gaumard simulators are interactive educational systems developed to assist certified instructors. Gaumard simulation systems do not substitute a comprehensive understanding of the subject matter and are not intended to be used for clinical decision-making.
End User License Agreement

Working with UNI®

Initializing the Simulator ................................................................. 2

UNI Interface .................................................................................. 2
   Battery indicator ........................................................................... 3
   Session clock .............................................................................. 3
   Power/Stand-by Button ............................................................... 3
   Language ...................................................................................... 4
   Quick Launch .............................................................................. 4
   Status/Details Controls ............................................................... 5

Virtual monitor ............................................................................... 12
   Waveform Menu ................................................................. 13
   Changing Vital Signs ............................................................. 14
   Noninvasive blood pressure .................................................... 14

File Sharing .................................................................................... 15
   File Sharing ............................................................................. 15

Palettes ......................................................................................... 16

Scenarios ....................................................................................... 17
   Scenario Screen ................................................................. 17
   Scenario Overview .............................................................. 17
   Scenario Controls ............................................................... 17
   Scenario Quick Launch ....................................................... 18
   Creating A New Scenario ..................................................... 18
   Additional Scenario Features ............................................ 20

Labs .............................................................................................. 25
   Preparing A Lab Report ......................................................... 25
   Send To Monitor ................................................................... 26
   Creating A Lab Template ....................................................... 27

Speech ............................................................................................ 28
   Prerecorded Sounds ........................................................... 28
   Streaming Audio .................................................................... 29
   Voice Activation ..................................................................... 29
   Prerecorded Speech ............................................................ 30
   Duplex Option ....................................................................... 31

CPR ............................................................................................... 31
   Session Information ............................................................. 32
   Testing .................................................................................. 32
Coach ........................................................................................................................................ 33
Report .......................................................................................................................................... 34

Shock/Pace Panel .......................................................................................................................... 35

Medication (Auto Mode) ................................................................................................................ 35
Administering Medications ............................................................................................................. 35
Removing A Medication .................................................................................................................. 37
Fluid & Gas ...................................................................................................................................... 38
Drug List Manager ........................................................................................................................... 38
Creating New Medications ............................................................................................................. 38

Provider Actions ........................................................................................................................... 43
Session Information ......................................................................................................................... 43
Team Logging .................................................................................................................................. 43
Tracking Provider Actions ............................................................................................................. 44
Creating New Provider Action Buttons ......................................................................................... 45

Event Log .......................................................................................................................................... 46
Adding Notes .................................................................................................................................... 47
Creating A New Session Log ............................................................................................................ 47
Saving The Log Information ............................................................................................................ 47

Evaluation Form ............................................................................................................................ 47
Using Built-In Evaluation Form Templates ..................................................................................... 47
Printing An Evaluation .................................................................................................................... 48
Creating New Evaluation Templates ............................................................................................... 49

Menu Bar .......................................................................................................................................... 50
File .................................................................................................................................................. 50
Manual Mode ................................................................................................................................... 50
Automatic Mode ............................................................................................................................... 51
Managing Profiles ............................................................................................................................ 51
Setup ............................................................................................................................................... 55
Monitors .......................................................................................................................................... 65
Auto Mode (Optional) ....................................................................................................................... 67
View ................................................................................................................................................ 70
A/V (Audio & Video) ......................................................................................................................... 71
Fetal Neo Link (Auto Mode) ............................................................................................................. 72
Help ................................................................................................................................................ 72

Myocardial Infarction Editor (HAL Only) ....................................................................................... 74
Heart Viewer ...................................................................................................................................... 74
mi controls ....................................................................................................................................... 74
EKG Controls ................................................................................................................................... 76

EKG Designer ................................................................................................................................... 77
Editing And Creating 12 Lead Rhythms Using The EKG Designer ................................................. 77
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor (Noelle Only)</td>
<td>79</td>
</tr>
<tr>
<td>Labor scenarios</td>
<td>80</td>
</tr>
<tr>
<td>Labor Duration</td>
<td>80</td>
</tr>
<tr>
<td>Initial Position Synchronization</td>
<td>80</td>
</tr>
<tr>
<td>Labor Graph</td>
<td>82</td>
</tr>
<tr>
<td>Labor Controls</td>
<td>84</td>
</tr>
<tr>
<td>Locking Mechanism And Release</td>
<td>84</td>
</tr>
<tr>
<td>Additional Labor Features</td>
<td>85</td>
</tr>
<tr>
<td>Fetal Monitor</td>
<td>86</td>
</tr>
<tr>
<td>Save Labor</td>
<td>86</td>
</tr>
<tr>
<td>Modeling (Pediatric/Newborn/Premie)</td>
<td>88</td>
</tr>
<tr>
<td>Hypoxia Model State</td>
<td>88</td>
</tr>
<tr>
<td>Cyanosis Levels</td>
<td>88</td>
</tr>
<tr>
<td>Modeled Therapy</td>
<td>88</td>
</tr>
<tr>
<td>NewroSim™</td>
<td>90</td>
</tr>
<tr>
<td>Initiating NewroSim™</td>
<td>90</td>
</tr>
<tr>
<td>NewroSim™ Instructor Interface</td>
<td>91</td>
</tr>
<tr>
<td>NewroSim™ Palettes</td>
<td>91</td>
</tr>
<tr>
<td>Cerebrovascular Model</td>
<td>92</td>
</tr>
<tr>
<td>Monitor Control</td>
<td>94</td>
</tr>
<tr>
<td>Appendix</td>
<td></td>
</tr>
<tr>
<td>Scenarios Planning</td>
<td>97</td>
</tr>
<tr>
<td>Thinking In Terms Of Palette Items</td>
<td>97</td>
</tr>
<tr>
<td>Smart Scenarios</td>
<td>97</td>
</tr>
<tr>
<td>Pro+ System Offline Updater (If Applicable)</td>
<td>99</td>
</tr>
<tr>
<td>Wireless Ad-Hoc Network</td>
<td>103</td>
</tr>
<tr>
<td>UNI Network Configuration</td>
<td>103</td>
</tr>
<tr>
<td>Gaumard Monitors Network Configuration</td>
<td>104</td>
</tr>
<tr>
<td>Configure The Vital Signs Broadcast</td>
<td>105</td>
</tr>
<tr>
<td>Microphone Boost for Streaming Audio</td>
<td>107</td>
</tr>
<tr>
<td>Warranty</td>
<td></td>
</tr>
<tr>
<td>Exclusive One-Year Limited Warranty</td>
<td></td>
</tr>
</tbody>
</table>
End User License Agreement

This is a legal agreement between you, the end user, and Gaumard® Scientific Company, Inc. ("Gaumard"). This software is protected by copyright laws and remains the sole property of Gaumard. By installing the UNI (the "Software") media, you agree to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled media and accompanying items to Gaumard at the address indicated below.

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install and activate the Software on one computer for use with one Interactive patient simulator system. The software may also be installed on any number of other computers at the same institution so that students may access the learning resources. One copy of the software may be made for backup purposes. You may not network this Software, or allow multiple users unless you purchased a multi-user workstation license. Sharing this Software with other individuals or allowing other individuals to view the contents of this Software is in violation of this license.

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws and international treaty provisions. Therefore, you must treat this Software like any other copyrighted material. You may not make this Software or copies thereof available in any manner or form or use, copy or transfer the Software, in whole or in part, except as provided herein.

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the contents of this Software to any other party.

4. Electronic Transmission of Software. If you received the Software by electronic transmission or by Internet delivery, by installation of the Software, you acknowledge that you have read and understand this license agreement and agree to be bound by its terms and conditions.

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto shall commence upon installation of this Software. This Agreement and the license granted herein may otherwise be terminated by Gaumard in the event that you are in breach of any provision of this Agreement. In the event of termination, you agree to immediately return this Software, accompanying items, and any copies thereof to Gaumard.

6. LIMITED WARRANTY

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE FROM DEFECTS IN MATERIAL AND WORKMANSHP. ELECTRONIC TRANSMISSION IS WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD.
(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY DESCRIBED ABOVE.

(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE.

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED BY GAUMARD.

ACKNOWLEDGMENT

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED HEREIN.
Working with UNI®
Initializing the Simulator

After reading the manufacturer’s care and caution information, press the power button to turn on the Tablet PC.

The UNI software initializes the simulator. Double click the UNI icon on the tablet’s home screen to start.

The simulator selection menu is shown. Select Noelle and click “Start”.

Notice that the serial numbers entered for each simulator will be saved.

The wireless link between UNI and the simulator is established within 1 minute.

The available profiles for each simulator will be displayed when the simulator is selected. For more information about managing and creating new profiles, refer to the “Menu Bar” section.

UNI Interface

The UNI software is used to control the simulator, monitor the vital signs, and evaluate the provider’s performance. The simulation technician or instructor carrying out the simulation operates the UNI software.

The UNI control elements and scenario programming procedures are consistent throughout the Gaumard family of high fidelity simulators. Some software controls and features covered in this guide may be hidden depending on the simulator’s hardware configuration and optional upgrades.
CONNECTION STATUS

The communication indicator displays the status of the radio link between the tablet’s USB RF module and the simulator. Full bars indicate excellent communication (i.e., normal operation).

BATTERY INDICATOR

The battery status indicator progresses as the battery in the simulator is used. The exclamation mark indicator is shown when there is no communication and battery information cannot be retrieved.

When the battery icon is depleted, the simulator is set to STAND-BY mode automatically to protect some of the simulator’s internal components. Simulator will not initialize until connected to the charger or the battery is replaced with a fully charged spare.

Internal battery duration is approximately 2 hours.

WARNING

Turn Simulator OFF before replacing the battery. Failure to do so could result in serious damage to the system.

SESSION CLOCK

The session timer allows the facilitator to maintain a chronological record for individual simulation sessions. The session timer can be reset from the file menu when a new simulation session begins, or by clicking the session time icon and then Reset Session Clock. Events during the simulation are logged in accordance to the session time.

POWER/STAND-BY BUTTON

The standby button is located on the bottom right corner of the UNI software. Use the stand-by feature to conserve battery during lectures.
6. Restart the UNI software to have the language option applied.

The scenario descriptions translated to the selected language are available for HAL, Victoria, and Noelle only. Future releases will include the scenario descriptions translated for the rest of the simulators.

QUICK LAUNCH

The UNI interface opens up showing the quick launch page for the scenarios. This page is used to easily access the preprogrammed scenarios saved on each profile.

3. Open the “Language” tab
4. Select the desired language

5. Follow the window message to restart the UNI software by clicking “Yes”.

The first scenario from the list is selected as default. Also, the scenarios are distinguished with icons as linear, branched, or labor.

CLINICAL CONDITION

The scenarios are categorized by clinical condition to the left of this page; i.e. shoulder dystocia, cord prolapse, etc.

Select the scenario type as show below.

Notice that one or more scenario types can be selected at the time and the list of scenarios on
the right will display only the scenarios included on the selected categories.

Notice that the position of the fetus should be selected before clicking “Start scenario” as shown below.

SELECTING THE SCENARIO

Click on one of the scenarios listed to highlight it and the scenario can be started immediately or loaded.

Preparing the actual simulator for delivery must be done before activating quick launch scenarios. For complete information refer to the “Working with Simulator” section.

FAVORITES

There is also a “Favorites” feature added to the quick launch program. This feature allows users to reduce the number of scenarios highlighted to those within the categories that will be used most frequently.

Enable the “Favorites” feature by clicking the start icon. Then select the categories or scenario types to be stored under this feature.

STATUS/DETAILS CONTROLS

The Status/Details panel is used to monitor and control the simulator’s vital signs. The individual parameter controls displayed on the details tab provide the simplest method for controlling the simulator’s vital signs, sounds, and features.

The Status/Details tab displays the vital signs controls in a list format.
To adjust numerical values click the slider control. (e.g. heart rate, blood pressure, respiratory rate, etc.).

Alternatively, use the keyboard for manual entry and click the green checkmark to confirm the change.

To change patterns, sounds, and rhythms, click on the specific control to display the library (e.g. EKG rhythms, heart and lung sounds, respiratory patterns, etc.).

The vital signs controls are divided into separate categories. Click through the categories to view the controls available for the current simulator configuration.
Notice that the EKG library includes a preview of the cardiac waveforms and

Click a trending timer to update numerical vital sign parameters (e.g. heart rate, blood pressure) gradually.

Click the slider control below the sound library to adjust the volume of the sounds.

Vital signs can be edited by clicking on the specific parameter.

---

**APPLYING CHANGES**

No changes will be made to the simulator’s condition until the new settings are submitted using the “Apply” panel.

After the list of changes is created, click “NOW” to update the vital signs instantly. Alternatively,
Also, use the edit and remove tabs to edit a new parameter or remove an existing one.

Notice that until the “apply” option is not selected, the vital signs in the Status/Details panel will not reflect the new changes.

Enable the “instant apply” option and click the control to change the vital sign to a new value without the need to use “Apply” panel. Vital signs undergoing change blink yellow.

Enter a name for the palette, a description, and choose color code. Click “Save” to create the new palette item. Palette items are stored in the active profile.

When the palette is needed, click the Load button to select the palette from the library.

Select the palette item from the “Load Palette Item” menu and click “Load”.

CREATING PALETTE ITEMS

A palette item stores one or more vital sign settings into a single loadable object. Use a palette item to update a set of vital signs quickly. For example, one palette item can be created to update all the cardiac parameters to a healthy state.

To create a new palette item, set the values for the desired vital signs parameters using the details controls and click “Save”.

---

User Guide | Working with UNI™ |
AUTOMATIC MODE CONTROLS

While operating in the Automatic Mode, UNI adjusts the patient’s vital signs automatically in response to caregiver participation, instructor input, and pharmacologic intervention. For example, if the heart rate is increased, UNI will calculate a realistic response to the event and adjust the blood pressure values automatically.

To enable the Automatic Mode as an option in the profiles menu, go to page 57.

Click “Auto Mode” to pause the automatic changes. To return the patient to the initial state, click “Reset”.

PATIENT PROFILE

Patient files store general information such as weight, height, and age. The automatic mode factors the patient’s weight as it adjusts related physiological parameters. UNI includes several
A default patient is loaded when the Quick Start Modeling Profile is selected and it is an ideal candidate for most simulations. Click the patient information bar to view the patient’s profile.

Some changes are gradual and even if submitted for immediate change. The delay results from using a closed loop model that adjusts to the target values over time, rather than displaying a unique value that is unrelated to other parameters.

LUNG CONDITION

The lung condition parameter adjusts the shunt flow, dead space, airway resistance, and respiratory pattern automatically.

TIDAL VOLUME

In the automatic mode, a tidal volume of 450 mL to 500 mL is considered the normal level for an adult of average build.

The “auto mode” does not restore the respiratory rate if it is set to zero. Always remember to specify a new respiratory rate.

The “Hold” and “Auto” options are unique to the automatic mode. The “Auto Mode” adjusts vital sign controls with an (auto) suffix automatically.

Checkmark “Hold” to prevent the Auto Mode from adjusting the value. Then change the vital sign to the new static value. The automatic mode will not change values set to hold. The “Auto Mode” will adjust all other controls set to “auto”.

CONTROLS

In the automatic mode, the Details panel includes additional vital sign parameters and control options not available in the Manual mode.
BLEED AND WOUND SIZE

The Bleed and Wound size options simulate blood loss virtually. To start the virtual bleeding, click the “Bleed” button, and then adjust the bleeding rate using the “Wound Size” control.

Once the bleeding function is activated, the Auto Mode will adjust the vital signs in response to the blood loss. If the provider does not intervene, the vital signs will deteriorate and myocardial ischemia will occur. For information on how to infuse blood to the model virtually, go to page 39.

CIRCULATION

Each cardiac rhythm has a specific effect on the blood pressure waveforms. The pressure waveforms include ABP, CVP, PAWP, and Pulse. The blood pressure values are affected when any of the following parameters are changed:

- Vascular profiles: vessel diameter and vessel stiffness
- Heart Rate
- LV Contractility
- Total Blood Volume

PATIENT STATE

Set the patient status to “Excited” (after exercise) to increase heart rate, temperature, respiratory rate, tidal volume, O2, CO2 diffusion capacity, metabolic rate, and CO2 formation rate. Set the status to “resting” for a normal state.

The progression of rhythms generally follows the pattern displayed in the figure below, where “X” represents normal sinus rhythm, multifocal atrial tachycardia, atrial flutter, atrial fibrillation,
virtual monitor

The interactive virtual monitor tab (VM) displays the patient's vital signs information in real time and 3D-Body view. The waveform and numerical parameters are interactive, and the layout is fully customizable. If the VM tab is not displayed by default, go to Menu section to activate the virtual monitor add-on.

body view

The "Body View" mode displays an interactive model of the simulator. The model is a representation of the simulator and its internal organs.

Use the Body View controls on the top to rotate, move, re-center, and zoom the model. Place the cursor over the body to view the model's internal organs. Also, reach the desired category in the list view clicking over the body view.

The body view includes the sensor panel, which detects the action performed and shows active sensors highlighted in green.
The Body View inside the Virtual Monitors window is available for all simulators except the Code Blue III Family, the 12 LEAD ECG simulator, and the Dynamic Lung Compliance simulator. Also, this view will be disabled when using the Micro+/Pro+ recording and debriefing system.

**SENSORS**

Use the sensors option to enable or disable any of the waveforms displayed in the vital signs monitor. Select the waveform and click “ON” to display the readings on the virtual monitor screen. To disable a parameter reading, click “OFF”. The vital signs monitor sensors defaults to “All On.”

Move the slider to enable or disable the sensors displayed on the virtual monitor screen. The sensor will show up as ON or OFF. In the example above, all the sensors are ON except the thermometer.

Use the audio icons to enable the sensors audio on/off on the Virtual Vital Signs Monitor.

Some sensors, such as NIBP and Thermometer feature a STAT control that will allow the facilitator to activate readings on the virtual monitors from the controller software.

**SENSOR CONTROL WINDOW**

The sensor control window is a floating panel with on/off toggle controls. Toggle between 3D-View and Sensors windows.

Alternately, click on the “Pop out sensors” tab to make the sensors windows a floating panel.

**WAVEFORM MENU**

Click on the waveform name to access the options or change the waveform type.

- Freeze- Click freeze to pause a waveform reading. To unfreeze the selection, click the waveform menu and select Go.
• Time- Click on the time option to change the length of the ECG waveform. The options available are 5 seconds, 10 seconds, 15 seconds and 20 seconds.
• Display- Click on the display menu to edit the wave form color, amplitude, intensity and scroll direction.

CHANGING THE WAVEFORM TYPE

The types of available waveforms are Pulse-Oximetry, Arterial BP, and Respiration.

1. To change which waveform is displayed on the ECG graph, begin by clicking the ECG icon then selecting “close”.

2. Click the waveform menu box and choose either the type of wave to be displayed or the ECG lead.

3. The new lead information is now displayed.

NUMERIC MENU

Click the numeric menu to access the numerical parameter options. To change the type of numerical parameter displayed, click the numeric menu and select “close”.

Click the empty numerical menu and select the new parameter type.

CHANGING VITAL SIGNS

Vital signs can be adjusted directly from the virtual monitor tab. First, Double click the vital sign parameter to access the floating control window. Then, adjust the parameter to the new value and submit the changes using the Apply NOW or trending option.

NONINVASIVE BLOOD PRESSURE

By default, the NIBP parameter does not update automatically. Click the NIBP menu and select “Stat” to refresh the reading. Alternatively, set
Open the “File Sharing” control from the icon or from the Menu/Monitors/File Sharing

**File Sharing**

**FILE SHARING**

The file sharing menu allows the facilitator to send images, audio, and text files to the virtual monitor screen. Use the file sharing feature to fulfill file requests by the provider during simulation.

The list of files stored on the Gaumard_UI folder available for sharing is displayed on the left panel. To share a file, select the file from the left panel and click “Send”.

The files used for sharing are stored in the control PC. Before the simulation begins, add mock image (.jpg, .bmp) or text files (.txt) into the Gaumard_UI folder located on the home screen of the control computer.

a refresh interval to automate the stat process periodically.
The x-ray file is now open on the virtual monitor computer.

To discontinue sharing the file, select the file from the file sharing menu and click "Recall".

Palettes

The Palette page appears identical in both the manual and automatic mode. Each item on the Palette represents a complete or partial physiological state. It displays all of the Palette Items in the active profile. Each profile has its own separately customized Palette. Recall that you can create Palette Items using the Details page.

Apply Palette Items using the buttons at the bottom of the page, just as changes to Simulator’s condition are applied on the Details list.
Editing existing Palette Items is simply a matter of selecting the item you wish to modify and clicking the Edit button. You will be taken automatically to the Details list, and the settings that comprise the selected Palette Item will be displayed. Change them as desired, and click the “Save as Palette Item” button.

Many of the functions related to Palette Items are also available by clicking the second mouse button (usually the right button) while the pointer is positioned over an Item. Note, when using the tablet computer, this is best done by holding the stylus button while tapping the screen.

**Scenarios**

Scenarios automate the vital sign changes, responses, and software actions required to carry out a complete simulation exercise. UNI includes several preprogrammed scenario based simulation exercises in the “Quick Start Profile”.

**SCENARIO SCREEN**

Use the panel buttons to clear, load, and save new scenarios.

To use a preprogrammed scenario go to the Scenario tab and click “Load Scenario”.

During the scenario, each vital signs palette updates the patient’s vital signs. The palette’s transition time trends the increase or decrease of numerical parameters (e.g. Heart rate, blood pressure) over seconds or minutes. In the figure below for example, the vital signs palette “Becca 2_1” is programmed with a transition time of 30 seconds. When the scenario reaches this palette, it will take 30 seconds for the vital signs to trend from the previous state to the values programmed within the palette.

Wait palettes do not update or change vital signs. Instead, wait palettes give the participant time to perform an action; this may be treatment in response to a complication or performing a standard assessment.

**SCENARIO CONTROLS**

Scenarios are controlled from the buttons at the bottom of the tab. The scenario plays palette items in much the same way a music player plays songs. Intuitively, the facilitator can play, stop, pause, skip, or repeat items as appropriate.

The Scenario Position Indicator points to the current item and shows the current status of the
scenario. The following paragraphs describe in detail the behavior of each button and indicator.

**SCENARIO POSITION INDICATOR**

- An unfilled triangle means that the scenario is stopped. When the Play button is clicked, the item being pointed by the indicator is played.
- A rapidly blinking triangle means that the scenario is playing the item to which the indicator is pointing.
- A slowly blinking triangle means that the scenario is paused at the item to which the indicator is pointing.

**SCENARIO PLAYER CONTROLS**

- **Play button**: Plays the item to which the scenario position indicator is pointing. This button has two states: play or pause.
- **Pause button**: Pauses the scenario. This state of the play button is only active when the scenario is playing. It is disabled when a ‘Wait indefinitely’ item is playing because in such cases the scenario is already paused.

  The Stop button has two behaviors depending on when it is clicked. When clicked once, the Stop button halts the scenario at the end of the item currently playing. When clicked a second time, the scenario is stopped immediately. For example, if the item currently playing has a transition of 1:00 minute and the Stop button is pressed when it has 0:10 seconds left, the scenario will be halted at the end of the transition (i.e., in 10 seconds). If the Stop button is clicked again within those remaining 10 seconds, the scenario stops immediately.

- **Previous button**: Similar to the Next button, the Previous button returns the indicator to the previous item in the scenario.
- **Reset button**: The Reset button stops the scenario immediately and returns the indicator to the first item in the scenario.

**SCENARIO QUICK LAUNCH**

Use the scenario Quick Launch tab to start a scenario with a single click.

The Quick Launch tab displays all of the scenarios saved in the active profile, for more information refer to the “Quick Launch” section.

**CREATING A NEW SCENARIO**

The general process of creating a new scenario is the following:

- Create a vital sign palette item for each state in the scenario
- Add nodes
- Add palettes to each node
- Add paths to nodes that require provider action
- Create key events to alter the progress and trajectory of the nodes within the scenario
- Add the vital signs palettes and wait times to the scenario
- Play the scenario
- Modify and edit palettes
- Save the scenario

CREATING PALETTE ITEMS

1. First, create the palette items that you will use in your scenario. Use the Status/Details to change the controls that best describe the condition you are trying to simulate. Not every field has to be populated in order to save a palette item.

2. Save your palette(s) by clicking on the “Save Palette” button on the upper right side of the page. The “Save As Palette Item” dialog box is now displayed. Assign a name to the Palette Item and specify a brief description. Also, select a color that represents the palette’s condition: green for healthy, red for critical, yellow for care required, and blue for other. Click Save.

3. After creating all the palettes, go to the Scenario tab and click on the “Add Item” button.

4. Select a single palette or enable Multi to select multiple palettes at the same time. Specify a transition time for the palette and click “Add”.

Notice that the palette properties are shown in the right column below the item description when a specific palette is selected.

5. Repeat step 4 to add more palettes, labor scenarios, wait times, speech, monitor sensors, files, and labs.

6. A “Wait” item maintains vital signs values steady for the transition time allotted. Insert a “wait” item to give the provider time to perform an action or an assessment. For example,
auscultating blood pressure or gathering general information about the patient. Alternatively, add “Wait Indefinitely” to hold the vital signs until the “next item” button is clicked from the playback controls.

7. The wait palette item is now added.

8. Also add “Time Lapse” to set a real time for the scenario. For example, applying a medication might take 2 and half hours to have the effect on the patient. So by adding this time lapse the real time can be reflected in the scenario, but it will happen in 10 seconds

9. Add more palette items.

10. Use the “Edit Item” menu shown below to move up and down the items, access the properties of each palette, edit the transition time, edit and delete the palettes.

ADDITIONAL SCENARIO FEATURES

Incorporate the following features into a scenario for added realism.

- Auto responses – move onto the next palette item automatically when virtual electric therapy is detected
- File sharing lab reports, and monitor sensors – Send files and lab reports to the virtual monitor computer, and enable monitor sensors
- Labor – add labor scenarios
- Speech – add phrases or custom speech

SPEECH

Add realism to a scenario by integrating automated speech phrases. Click the Add to scenario button and select Speech. Then, select the type of speech and phrase using the menu.

FILE SHARING, LAB REPORTS, AND MONITOR SENSORS

The scenario can also automate the distribution of shared files, labs and monitor sensors. Click “Add to scenario”, and then use the “File”, “Lab”, and “Monitor Sensors” tabs to select from
Auto-responses advance to the next palette if the virtual shock is applied while a “wait indefinitely” palette is playing and the heart rhythm is “shockable”.

The three response options are defined below:

- **Off** - The scenario does not respond to the electric therapy.
- **Prompt** - The software detects the electrical therapy and prompts the user for approval before advancing to the next palette.
- **Auto** – Advances to the next palette automatically only if the electrical therapy meets the threshold specified.

Notice that by this point, a lineal scenario is created by adding items to a single node.

To create a branched scenario with multiple nodes and paths, follow the instructions below:

**ADDING NODES**

A branched scenario will consist of several “Nodes”. Each node is pre-configured to run a scenario or a series of palettes. The facilitator will then activate key events that will alter the trajectory of the nodes.

1. Click “Add Node” near the top of the window to begin.

**AUTO RESPONSES**

The scenario auto-response settings move the scenario to the next palette when electrical therapy is detected. Electrical therapy can be applied by the facilitator via Virtual Shock panel or by the care provider using real medical equipment if the simulator supports it.
2. Click the node’s identifier button. Click Save to apply changes to edit the node name and description.

3. Click the drop down menu to edit the node.


ADDIMG PATHS

A path refers to the trajectory from one node to another after the last palette in a node expires.

1. Click on the time limit icon to modify the “go to” point for the default path. After the last palette expires, the scenario will move on to the node as indicated by the arrow.

2. Configure the countdown timer and the “go to” point for the default path. Click OK to save.

Add more nodes each with palette items to simulate every stage in the scenario. In this example, several nodes simulate the effects of medications that maybe administered to the patient by the provider. The first two nodes simulate the complication [1] Start Bradycardia, [2] Deteriorate. The following nodes: [3] Interventions, [4] Atropine, [5] Epinephrine, [6] Dopamine and [7] Pace are activated only when the provider administers the applicable medication or electrical therapy. Each node is programmed with palettes that simulate the effect described.
Custom tab allows to type a name for the event and then click “Add”.

The remaining key event tabs like Electrical Therapy, CPR, Airway, and Drug Recognition have a drop down menu to select the different options.

The Electrical Therapy key event includes:
• Defibrillation Shock
• Cardioversion Shock
• Non-Sync Shock
• External Pacing
Select one of the options, then, set the parameters for response to either joules or number of shocks and click “Add”.

The CPR key event includes:
• Correct Compressions
• Correct Ventilations
• Correct Compressions and Ventilations.

KEY EVENTS

Key events allow the facilitator to alter the trajectory of a branched scenario. This is done by assigning multiple paths to a single node, then selecting one of the paths when the provider completes a desired task. To add a key event to a node:

1. Click the Add path button, then the edit button located on the right.

2. Use the Edit Path window to name, rename, sort and create key events.

KEY EVENTS MENU

A key event is the action expected by the participant. The Key Event Menu includes Custom, Electrical Therapy, CPR, and Airway.

Node 1 is now configured to continue to Node 2 as indicated by the path’s “go to” point.
In the figure below, node 2 is configured with four alternate paths. Once the provider performs any one of the actions listed as key events, checkmark the key event to activate the alternate path.

The key event is now programmed to move the scenario to node 8 if pacing is detected.

3. Click “Save Scenario” to store the scenario in the current profile for later use.

4. Type in a name, assign a system and a clinical condition. Then, add a description for the new scenario and click Save.
Labs

Use the Lab tab to create mock laboratory test results to aid the participants during simulation. In addition, create new laboratory templates to supplement different types of scenarios. Once a laboratory report is created, send the file to the virtual monitor screen for the providers to access during the exercise.

PREPARING A LAB REPORT

To create a new lab report with mock test results:

1. Click “Create a New Lab Report” on the right panel.

The “Edit Lab Report” window is displayed.

2. Select a “Lab Template” from the drop down menu.

3. Enter a report name, a report time, and a description. In addition, select a color tag for the lab report on the right panel. Color tags aid the sorting of lab reports on the report list window.

4. Enter the test results in the “Value” column. Include any comments associated with the test performed.

5. Click “Save” to create the lab report.
2. Click “Send to Monitor” button to transfer the lab report to the virtual monitor.

3. An exclamation icon notifies the provider a file is ready for access on the Gaumard Monitors. Instruct the participant to click the patient menu drop down and select the lab report.

4. The lab report opens using the system’s default application.

5. The letter Y represents a shared document. Click the “Stop Sharing button” on the right panel to remove the lab report items from the Gaumard Monitors menu.

6. Click “Preview” to review the final lab report.

The newly created lab report is now listed in the “Lab Reports” section. Sort lab reports by name, template, description, or color tag.

SEND TO MONITOR

Send the completed lab report to the virtual monitor screen to assist the care provider.

To transfer the lab report to the virtual monitor screen:

1. First, select the report from the lab reports list.

The preview window displays the test results how the provider will see them on the virtual monitor screen. If the computer is connected to a printer, click PRINT to create a hard copy.

An editable copy of the lab report is stored inside the Gaumard_UI folder on the computer's home screen. Go to page 19 for information on how.
to access other files from the Gaumard Monitor screen.

**CREATING A LAB TEMPLATE**

Build new lab templates to supplement new scenarios.

To create a new laboratory test template:

1. Navigate to the bottom of the tab and click “New Template”.

2. Enter a name for the new template followed by a description.

3. Create categories to group a series of tests in a lab report. Click “Add” to create a new category.

4. Enter the name of the category and click “OK”.

5. Click “add” on the “Single Entry” menu to create a new test under the current category.

6. Enter the name of the test, the unit, and decimal precision.

7. Enter a “Normal Range” as a reference for the provider. The normal range is visible on the lab report. The “Allowed Range” restricts the minimum and maximum value that can be entered as test result. Click “OK” to add the new test.
Click the volume icon to preview the sound before to play it.

The new template is listed on the “Lab Template” section at the bottom of the Lab tab. Use the buttons on the left panel to edit or delete lab templates.

Speech

PRERECORDED SOUNDS
Select the Speech tab to command the simulator to speak aloud. The collection of speech and other sounds covers a wide range scenarios. In addition, use the streaming voice option to speak as the simulator’s voice and listen to the student responses.

SPEECH TYPE
The Speech window allows user to arrange the phrases into new speech types to meet your simulation requirements.

Follow the instructions below to create a new speech type:

1. Click “Add type to create a new speech category

   LOCATION
   OCCURRENCE
   REPLY
   URGENCY

   Add Type
2. Enter a name for the new type and click “OK”

![Image of a text input interface with an “Emergency” category selected.]

3. Select the phrases to be included into the new speech type using the “Plus” icon and select the name of the new type

![Image of a complaint list with options such as “Back pain,” “Bleeding,” and “Emergency.”]

The phrases will be listed into the Emergency category now.

![Image of a text input interface with a “Plus” icon to add phrases.]

VOICE ACTIVATION

Enable the “Voice Activation” feature to switch to the talk mode when voice input is detected automatically. Adjust the mic threshold to set the voice activation sensitivity. The higher the threshold, the less sensitive the microphone is; and vice versa. For instance, if the threshold is

STREAMING AUDIO

Use the streaming voice to speak as the simulator’s voice and engage the provider in a realistic conversation. In addition, record and save custom phrases to be played back during scenarios automatically.

Ensure that the headset and microphone are connected to the PC before starting the UNI software. The headset minimizes echo and environmental noise to improve audio quality.
set to high, the voice input volume must be high to trigger the voice activation.

### PRERECORDED SPEECH
Create a library of custom recordings to play back as the simulator's voice using the "Prerecorded Speech" feature.

### VOICE RECORDER
To record a new custom phrase:

1. Click the “Rec” button and speak into the microphone.
2. Press “Stop” to finish recording.
3. Enter a name and click “OK.”

### VOICE CLARITY
Voice clarity can be affected by several factors. To improve audio for the listen and talk options please review the following information.

- Connect the headset to the computer before activating the Gaumard control software.
- Connect to the simulator using the strongest channel. Assign separate channels to each simulator if working with multiple simulators at a time.
- Adjust the physical mic control attached to the headset cable.
- Adjust the streaming voice “Output Gain.” To raise the output gain in increments, tap and hold the control, then slide to the desired level. Higher gain levels increase the talk volume but degrade the audio quality.
- Fine-tune the Windows® microphone settings. For more information on the Windows® settings, go to page 95.
4. The new phrase is listed under the “Prerecorded Speech” menu.

SPEECH LANGUAGE

There are 4 available languages (English, Finnish, Spanish, and French). English is selected as default, switch the language option to have the simulator phrases in any of the other 3 languages available.

DUPLEX OPTION

Duplex streaming voice allows the use of a duplex headset feature to switch to the talk mode when voice input is detected automatically.

The Duplex module is available for Victoria simulator. If the simulator has this option, the UNI software will enable it automatically.

Click on the “Full Duplex” icon to use this option.

Use the Output Gain to increase or decrease to simulator voice’s volume while talking with the Full duplex.

Toggle between “Low Pitch” and “High Pitch” to modify to the pitch while the facilitator is the voice of the simulator.

CPR

UNI features a CPR performance evaluator and trainer. Compressions and ventilations effectiveness during CPR can be evaluated according to the user defined settings.

Click the CPR icon on the vertical menu bar to open the CPR window.

This tool allows the instructor to get real-time feedback on the current compressions and ventilations being done by the providers.
It is important to know that the chest compressions will only give feedback to the instructor if the blood pressure is below 60, and ventilations will only be reported if the respiration rate is set to zero.

This means that if the provider is performing good chest compressions according to the instructor defined settings, the waveform capnography will show the EtCO2 value higher than 10 mmHg.

SESSION INFORMATION

Assign the provider who will perform compressions.

Assign the provider who will perform ventilations.

For instructions on how to create a provider list, refer to “Provider Actions” subsection inside the “Working with UNI” section.

ETCO2 GAIN

The eCPR evaluator has incorporated the ETCO2 gain which is compliant with the 2015 AHA recommendations.

The waveform capnography allows providers to monitor and optimize the chest compressions.

High quality chest compressions are achieved when the ETCO2 value is at least 10-20 mmHg according to the 2015 AHA recommendations.

The ETCO2 gain control in the UNI software allows the user to increase or decrease the gas exchange in the lungs resulting in a very low to normal exhaled CO2 value when performing chest compressions.
TESTING

The test mode provides compression and ventilation feedback in real time without audible cues.

To begin, press the Start button. Perform compressions and ventilations to obtain:

- Compression rate and depth indicators:
The compression rate and depth indicators are located to the left of the CPR window. The indicator’s fill color changes between the following states:
  1. Orange/Red: compression depth and rate were either too shallow or too deep.
  2. Green: compression depth and rate were performed in the correct range. This includes full release.

- Ventilation volume and duration indicators
The ventilation volume and duration indicators are located to the right of the CPR window. The indicator’s fill color changes between the following states:
  1. Orange/Red: ventilation volume and duration were either too weak/short or too strong/long.
  2. Green: ventilation volume and duration were performed in the correct range.

Compression/Ventilation ratio is located in the center of the CPR window. The No-Flow Time shows the time without performing compressions.

- Graphical representation of compressions and ventilations: the ventilations are represented by the blue segment and the compressions by the red segment.

- Airway system view: The lungs and trachea are responsive to provider actions.
• Comp/Vent Cycles and CPR Time

Comp/Vent Cycles value shows the number of cycles performed. The CPR Time shows the total time of the CPR activity.

The coach mode generates audible cues of the compression to ventilation ratio programmed in the Options menu. For example, if this ratio is set to 30 compressions to 2 ventilations, the coach mode will start with 30 short beeps to signal the compressions followed by 2 long beeps to signal the ventilations.

Notice that the ventilation beeps will not start until the first ventilation is detected. The compression and ventilation beeps will be synchronized with the compression rate and ventilation duration.

In addition to providing training on the CPR rate, the coach mode also enables audible commands when the compression meets the following criteria:

• If the compressions per minute are below the programmed settings, the audible command FASTER is played.
• If the compressions per minute are above the programmed settings, the audible command SLOWER is played.
• If the compressions depth is below the programmed settings, the audible command HARDER is played.
• If the compressions depth is above the programmed settings, the audible command TOO DEEP is played.
• If the compressions recoil is not complete, the audible command RELEASE is played.

Compression and ventilation data is displayed in the log window as CPR is performed by the provider.

CPR SETTINGS

Access the CPR settings to adjust:

• Compression per Ventilation Ratio
• Compression Rate
• Ventilation Rate
• Compression Depth
• Ventilation PIP (Peak Inspiratory Pressure)
• Ventilation Duration

REPORT

After completing a CPR session, load the results by clicking the “Reports” button. A drop down menu will load with a list of the available reports.
Reports are saved automatically in the computer Program files: C:\Program Files\Gaumard Scientific\CPR Trainer\eCPR Reports.

Shock/Pace Panel

The shock panel is a floating window used to apply electrical therapy to the patient virtually. Go to Scenarios section for more information on how to work with the “auto responses” feature and the virtual shock panel.

Click the lightning icon to open the “Shock/Pace” panel.

Medication (Auto Mode)

The Medication tab is exclusive to the automatic operating mode. Use the medication controls to simulate the physiological effects and reactions of medications administered to the patient model. To simulate the effects of a medication, the UNI software processes the drug’s properties, dosage, and interactions, and then adjusts the patient vital signs accordingly.

The Meds Profile includes a library of preprogrammed drugs. The built-in drug editor allows facilitators to stay current with new medications or make changes to the properties of the existing drugs. All of the preprogrammed drugs included in the Med Profile library are found in the 2008 Handbook of Emergency
2. Rotate the lower right arm so the palm of the hand is facing up, and place the syringe holder on the simulator’s wrist.

3. Place the syringe without the needle in the holder. The syringe must be perpendicular to the surface of the forearm.

4. Select the drug from the drop-down menu and enter the concentration.

5. Click “Add” to program the syringe. The programmed medication is now listed on the medication list.

6. Write the medication name and concentration on the label provided and adhere it to the programmed syringe.

Repeat procedure to program additional tagged syringes with different medications.

VIRTUAL MEDICATION

To administer a medication from the Medication tab:

The “Set Medication Identifier” dialog box is displayed.
1. Select the medication from the Drug drop down menu.

![Medication Selection Screen]

A brief description is displayed at the top of the window. The half-life, peak time and drug concentration values are listed in addition to the standard and over dose dosage.

2. Enter the dose, units, route and rate (if applicable), and click “Administer”.

![Dose Entry Screen]

3. The “Proceed Drug” window prompts to confirm the dosage effects before applying them. Adjust the peak effect percentage and/or the dosage effect, and then click “Yes” to apply the effects.

![Proceed Medication Window]

To turn off the Proceed Drug prompt, click Setup>Auto Responses and change the Drug Model Effect settings to “Auto”.

The administered drug panel displays information on dosage rate, does administered, and total time of administration.

![Drug Administration Panel]

The Auto mode adjusts the patient’s vital signs to simulate the effects of the drug automatically.

![Auto Mode Simulation]

The blood pressure continues to decrease in response to the medication’s properties.

![Blood Pressure Monitoring]

![Vital Signs Table]
After the dose administration is complete, select the drug and click “Remove from list”.

To remove all the medications from the list and reset the effects on the patient model, click “File > New Session”.

FLUID & GAS

The automatic mode can process the administration of gas and/or fluids to the patient model.

Select from saline, blood, or oxygen and the volume/concentration and rate. Click on “Start” to administer.
To create a new medication:

1. Create a palette item using details page for the effects of a standard dose (SD). Then, repeat the process to create a palette item for the effects of an over dose (OD). For general information on creating a palette items, please go to section “Palettes”.

2. After dose effect palettes are created using the Details controls, go to the drug tab and click the “Manage Drug List” button.

Each medication is programmed with two palette items. One palette item is programmed with the vital signs adjustments to simulate the effects of a standard dose (SD), and the other palette item is programmed with the effects of an over dose (OD). Additional information such as half-life, peak time, and route is also programmed into the medication properties.

When the medication is administered to the patient, the software applies the palette item associated with the dose threshold. The Auto Mode adjusts the vital signs changed by the palette item gradually to simulate the medication’s effect on the patient.
The Add New Medication window is displayed.

3. Type the name of the new medication (e.g., Generic Name (Brand Name)) and enter the medication’s description and the dosage information.

4. Select the units and the administration route.

5. Enter the drug’s Half Life and Peak time.

6. Enter half-maximal effective concentration.

7. Select the standard dose (SD) effect palette created earlier and then click the applicable dosage button to assign it to the threshold. Repeat this step to assign the over dose (OD) effect palette to the Over Dose threshold.

8. Select the threshold unit and set the dosage amount that will trigger the programmed palette effect.
9. Click “Add” to save the new medication to the Medication List library.

The physiologic model will adjust vital signs to simulate interaction effect.

**DRUG EFFECT TESTER**

After configuring the drug properties using the “Add New Medication...” menu, click the “Update Graph” button to generate the effect-plasma concentration results. Continue to the next section to program interactors for this drug.

Click “Drug Interactions” on the “Add New Medication...” window to open the Drug Interaction editor.

**PROGRAMMING INTERACTORS**

To program one or more medications to interact with the current drug:

**DRUG INTERACTION EDITOR**

Use the “Interaction Editor” window to program drug interactions. When two or more medications preprogrammed to interact are administered,
1. Select the interactor from the drug list click “Add”.

![Interactor Editor](image1)

Information about the interactor drug is displayed in the Interactor Data window.

2. The drug is included into the interactors list. Repeat the process to add more drugs to the interactors list if necessary.

![Drug List](image2)

3. Select the interactor and click “Edit”

![Drug List](image3)

4. Adjust the Max Alpha to modify the type of interactivity effect. Monitor the graph for a visual model of the plasma concentration.
   - Alpha = 1: Additive
   - Alpha < 1: Synergistic/Induction
   - Alpha > 1: Antagonistic/Inhibition

![Max Alpha](image4)

**TEST PANEL**

Use the test panel to simulate the interaction between the drugs based on dosage and time of administration.

![Test Panel](image5)

To simulate the medications interactivity using the test panel:
1. Enter the patient’s weight and the dose for each drug.

2. Enter the time of administration for each drug and click “Update Graph”.

The results indicate that the maximum interaction effect (82.39 %) occurs at 00:46:51. The alpha at that point is 1.01 and the drug effect for each drug is reduced by 0.90%. Fine-tune the Max Alpha control and retest if the drug interaction effect is not realistic.

3. Right click anywhere on the graph access the zoom and print options.

4. Click “Confirm” to save the settings.

5. Review all the properties of the new medication in the “Add New Medication…” window, and click “Add” to save the new changes.

In the example below, two drugs preprogrammed to interact have been administered. The interaction information is listed in the Interaction Status panel.

A time-effect graph is generated from the test results. Tap and hold to draw a zoom area.
Provider Actions

Use the Provider Actions tab to track actions performed by the provider manually. Each option on the Provider menu generates a time stamped entry in the text log below.

1. Click "Add Provider" button to add a new provider.

2. Enter one provider per line and click "save" to generate the list.

The provider list will be available in the right column under the session title.

3. Select the session listed and click "load"

The provider names are now added to log tab.

To add a new provider independently to the "Provider Actions" window:

1. Click "Add Provider" button to add a new provider.

SESSION INFORMATION

Enter the session tile information and the name of the facilitator at the start of the session. The information is included in the final log report.

TEAM LOGGING

The team logging feature is used to track the individual actions of up to 19 providers manually. The feature records the name of the provider with the action as an event entry in the log.

Provider names can be entered individually or a provider list can be created:

To create a provider list to the "Provider Actions":

1. Click "Provider List" button to add a new provider.
2. Enter the provider’s name and select a color tag. Click OK to save the provider.

3. The provider is now added to the log tab. Repeat the steps to add up to 19 different providers.

**TRACKING PROVIDER ACTIONS**

Provider actions can be tracked as a team or individually. Click the provider’s name to set the provider as active and track the actions individually.

4. The following log entry is generated with the name of the active provider who performed the action:

   ![Log Entry Example](image)

   Click the “Team” button to deactivate the active provider and return to general logging. Right click the provider button to delete or rename a provider.

**CREATING NEW PROVIDER ACTION BUTTONS**

Create new clickable provider action buttons to expand the library of actions. To add a new action to an existing category:

1. Click the + button on the category

   ![Provider Actions](image)

   Click the appropriate option to track the action. For example, if the provider assesses the patient’s responsiveness by requesting them to open their eyes, click the “Assess responsiveness” button and select “Open your eyes”.

   ![Provider List](image)
2. The category menu is displayed

3. Enter the name of the action and select the type of action

   **Airway - Custom Log Button...**

   1. **Action:**
      Ventilate  

   2. **Action type:**
      - Descriptive Action
      - Responsive Action

   3. **Descriptive Actions:**

4. Enter a description for the possible action and click + to add. Repeat the process to add several actions.

   **Airway - Custom Log Button...**

   1. **Action:**
      Ventilate  

   2. **Action type:**
      - Descriptive Action
      - Responsive Action

   3. **Descriptive Actions:**
      - Mechanical ventilator
      - BVM
      - Transport ventilator

5. Click OK to save

The new action is listed in the airway category.

To create a new Action Group:

1. Click “Add Action Group” button

2. Enter a name and click “OK”
Select “patient vital signs” options to view a snapshot of the vital signs values when the event occurred.

The new action group is now listed. Use right click to edit or remove the new category.

**Event Log**

The event log records a time stamped entry of events that occur during the simulation session. In addition, every individual entry records a snapshot of the vital signs parameters when the event occurred. The text log records the following events:

- Vital sign changes applied manually or made by scenario
- Events detected by onboard sensors (e.g., intubation sensor, defibrillation sites)
- Preprogrammed speech phrases
- Satisfactory or unsatisfactory evaluation
- Facilitator notes

Select an entry from the list and right click to view additional options.

**ADDING NOTES**

Enter notes into the “add to log” field to record notes manually. The information is categorized in the log as “NOTE”.

**CREATING A NEW SESSION LOG**

The log event “time stamps” reference the UNI session clock. At the start of a new simulation exercise, click File>New Session to reset the session clock 00:00:00, reset any vital parameters settings, and clear all the event entries.
SAVING THE LOG INFORMATION

The log information is recorded in a rich text format. Export the log information to save a detailed history of the events that occurred during the session.

To save the session log report as a text file:

1. Click FILE>Save report
2. Enter a name for the report
3. Select the desired name and path, and click “Save”.

Evaluation Form

The evaluation tool assists facilitators in reporting and assessing provider interaction using a questionnaire form. A completed evaluation form can then be stored as a digital document or printed for distribution.

Evaluation Name: Ectopic Seizure
On-Site Reviewer: Jane
Date: 01/30/2013

1. Problems Identified

Evaluation Name: Ectopic Seizure
On-Site Reviewer: Jane
Date: 01/30/2013

Evaluation Name: Ectopic Seizure
On-Site Reviewer: Jane
Date: 01/30/2013

Evaluation Name: Ectopic Seizure
On-Site Reviewer: Jane
Date: 01/30/2013

USING BUILT-IN EVALUATION FORM TEMPLATES

Several preprogrammed evaluation templates included in the UNI software. Each template includes a set of multiple-choice questions, fill in the blank, and true or false questions for a variety of scenarios.

Select an evaluation template from the “Load template” drop down to begin.

Enter the name of the facilitator administering the evaluation in On-Site Reviewer field.

Complete the form by answering each question.

Click “Print” at the top right corner of the screen once the evaluation is completed.

Select the Microsoft XPS Document writer to save the finished evaluation as a digital document. Click “Print” to save the digital copy in the system.
Select the printer device from the list box and click print.

It is recommended that documents be first saved as XPS files before being printed into hard copies.

---

**PRINTING AN EVALUATION**

If the PC is connected to a printer, select and open the evaluation document saved in the previous step.

Navigate to the XPS Viewer file menu and select "Print".

---

**CREATING NEW EVALUATION TEMPLATES**

Create new evaluation templates for new scenarios using the edit mode. To enter the edit mode, toggle the “Go To button” located on the top right of the evaluation form window.

Enter a name for the new evaluation template in the “Evaluation Name” field.

Click “Add” on the Category menu.
Select the category type and enter the category title. Click OK to save.

Repeat the previous steps to add more categories, questions, and multiple-choice options.

The new category is now created.

Highlight the new category and then click “Add” on the “Multiple Choice Entry” menu.

Type the evaluation statement in the new multiple choice field.

After the evaluation template design is complete, click Save at the top of the window.

The evaluation form is now available for use.

Menu Bar
When first starting out with the simulator, it is recommended that you use the Quick Start profile, which was created in conjunction with experienced healthcare instructors and working medical professionals.

The Quick Start profile has applicable Palettes that are useful for simulating common medical emergencies. For many applications, it serves a convenient starting point that can be customized to fit most simulation objectives. It includes a library of predetermined scenarios.

The UNI control software has two modes of operation: Manual and Automatic. Each mode includes a Quick Start profile with preprogrammed scenarios exercises created in conjunction with experienced healthcare instructors and working medical professionals. Continue to the next section to learn more about each operating mode and the profiles included.

After selecting an operating mode and profile, click “Load” to continue.

In the “Manual” operating mode, the facilitator fully controls the vital signs and physiologic responses.

The Manual mode includes the following profiles:

**MEDS PROFILES**

Includes a library of fifty-two pre-programmed drugs to be used on simulations.

**QUICK START SIMULATOR MODELING**

Includes a library of predetermined scenarios.
MANAGING PROFILES

Use the Settings Menu to create a new profile and edit this profile.

Also the profile folder location will be shown below the “Select Storing Location” icon under advances settings.

Assign a name to the folder and click “OK”

The new profile folder location will show up. Then proceed to create a new profile, see instructions detailed below.

Use the “Reset Storing Location “ icon to reset to default profiles folder.

CREATING A NEW PROFILE

Profiles store palette, scenario, and option settings independently; changes made to one profile have no effect on the others. Below are some examples on how profiles are used.

• Assign one profile to each user of your Gaumard simulator system
• Use profiles to organize and protect palettes and scenarios
• Create a profile dedicated to a specific academic course taught by multiple instructors
• Devote an entire profile to one particular subject area, or even one particular scenario

To create a new profile, click “New Profile”.

Enter a name for the new profile followed by a description.
To lock the new profile created, enable PIN security and enter a 4-digit-pin number.

Enable the PIN protection to prevent unauthorized users from accessing or making changes to this profile.

Lastly, click “Create” to save the new profile.

Click “Unlock Profile” to remove the restrictions over this profile.

NEW SESSION

Clicking New Session in the file menu will:

• Clear any loaded/playing scenario
• Clear any loaded/playing palette
• Reset vital signs to normal values
• Clear out log page
• Restart the session clock.

The session clock is located at the bottom of the dialog box.

The shortcut key for starting a new session is: Ctrl + N
RESET SESSION CLOCK
Clicking on Reset Session Clock resets the clock back to zero. It does not have any effect on the transition time remaining on a scenario; it does not reset the vital signs, or clear out loaded scenarios. The facilitator can also reset the session clock by clicking on the Session button next to the session time.

SAVE REPORT
This option allows you to save all the information recorded in the log page as a text file. Clicking on it brings up the “Save As” dialog box:

Select the desired name and path, and click “Save”.

The shortcut key for saving a report is Ctrl + S. For a sample report, look at the figure below:

PRINT REPORT
This option allows you to print a text file containing all the information in the log for the latest session. Clicking on “Print Report” brings up the Print dialog box. The shortcut key for this option is Ctrl + P.

IMPORT
Use the “Import” menu to import palettes, scenarios, and modeling patients created on another PC or stored in a backup location.

To import an item into UNI:
1. Click File>Import on the menu to access the “Open” menu.
2. Set the type of file to import.
3. Browse to the location where the item is saved and click “Open” to import.

The scenario file is copied to the UNI scenario library automatically.

EXPORT
Use the Export feature to backup palettes, scenarios (branched or linear), and model patients files.

To export an item and save it to a location on the computer:
SETUP

This tool allows you to easily calibrate the sensors inside the simulator. First choose which function you would like to calibrate: chest compressions, artificial ventilations, or blood pressure cuff. The Simulator will not breathe or have chest rise during any calibration procedure.

- Pupil Sensitivity
- Chest compressions
- Artificial Ventilations
- Blood Pressure Cuff
- Oxygen Saturation
- IV Medication Infusion (Drug recognition)

1. Click File > Export to open the “Export” menu
2. Select the file type from the “Export File Type” drop down menu:

   ![Export File Type](image1)

3. Select the item to export from the list and click “Export”

   ![Export](image2)

   The “Save As” window is displayed.

4. Browse to the location where the file will be saved and click “Save”.

   ![Save As](image3)

EXIT

Click File > Exit to close the UNI software and turn the simulator off. Alternatively, click the power bottom and click the X icon near the top corner of the screen.
PUPIL SENSITIVITY

The simulator’s pupils react to light. Use the “Pupil Sensitivity” controls to recalibrate the pupil reaction if dilation is erratic.

Calibrate current ambient light - Click “Ambient Light” to recalibrate the pupil diameter to the current ambient light.

Calibrate low intensity Light - While covering both eyes from most incoming light, click “Low intensity Light” to set the low light pupil diameter.

Finetune pupil reaction to direct light - Click increase or decrease to adjust the pupil’s sensitivity to light.

Reset pupil sensitivity to factory settings - Reset the pupils’ ambient and low intensity light to the factory settings.

CHEST COMPRESSIONS/ARTIFICIAL VENTILATIONS

This tool helps you calibrate the chest compressions and the artificial ventilations to your specific criteria. That is, you will be telling the system what a correct chest compression is and/or what a correct artificial ventilation is. Providers will be evaluated by the system based on this criteria.

If the simulator includes a compression sensor that determines the depth in inches/cm, the calibration for chest compression will be disabled.

The chest compressions and ventilations are calibrated the same way. After making a selection, this dialog box is displayed:

Click next to proceed with the calibration.

The software will now ask you to perform a number of “correct” chest compressions or artificial ventilations, depending on what you are calibrating.

The facilitator should follow the text cue on the screen to perform just ONE compression or ventilation at a time, until prompted for the next one.
For example, if calibrating the left arm:

1. The wizard prompts you with “0 mmHg.”
2. Set the pressure on the BP cuff to 0 (i.e. cuff valve open).
3. Click the “OK” button.
4. The wizard prompts you with “20 mmHg”.
5. Set the pressure on the BP cuff to 20 mmHg.
6. Click the “OK” button.
7. A green filled oval indicates that the value was successfully set.
8. Continue the process as instructed by the screens.
9. Once the prompt reads “Done”, go back and calibrate another function or click the “Finish” button to close the calibration wizard.

OXYGEN SATURATION

This feature allows you to calibrate the oxygen saturation.

**WARNING**

Oxygen saturation is calibrated to match a specific oximeter. Repeatability is accomplished when using the same oximeter and sensor. Even if the oximeter is interchanged with another one from the same brand and model, the reading might not coincide. To avoid reading discrepancies, calibrate this feature each time a different oximeter or sensor is used.
Co-Oximeters that in addition to reading oxygen saturation also read carbon monoxide (SpCO) and methemoglobin (SpMet) do not work with this simulator.

To calibrate the oxygen saturation, follow the steps below:

1. Make sure that the oximeter is turned off. Place the oximeter sensor all the way into the index finger, making sure the finger is at the center covering the emitting and sensing element.
2. Go to Setup>Calibration and select “Oxygen Saturation”. Click “Next”.
3. Select which finger you want to calibrate, left or right. Then click “Next”.
4. Turn on the oximeter and click “OK” on the dialog box.
5. The oxygen saturation calibration dialog box is displayed (for 98%).

6. Using the arrows on the left column of the calibration dialog box, adjust the reading on the oximeter monitor screen, to match the 98 displayed on the UNI screen.

For large increases or decreases, use the triple arrows. For moderate changes, use the double arrows. Use single arrows for small changes of one or two percent reading (only for 98% calibration).

7. Click “OK”. The calibration oval blinks green before showing the next value.

The oxygen saturation calibration dialog box for 80% is now displayed. Calibrate using the instructions from step 7 and 8.

8. The oxygen saturation calibration dialog box for 60% is now displayed. Calibrate using the instructions from step 7 and 8. Once you achieve the desired results, click “OK”.

9. After the calibration oval blinks green, the following dialog box will be displayed, indicating that the calibration has been completed.

10. Click Finish.

TESTING THE CALIBRATION

1. Go to the details page and vary the oxygen saturation value on the software.
2. Observe that the oximeter reading coincides with the value you specified (±3 differences are acceptable on readings above 80%).
3. Test calibration at two points; values between 80 and 95% are recommended.
4. Now take the oximeter sensor off the finger, wait for five seconds and again place the sensor on the finger.
5. Make sure to slide the finger all the way into the oximeter sensor and in the same position as it was calibrated.
6. Check that the oximeter reading coincides with the value specified on the Details page (±3 % value differences are accepted).

If it does, you are ready to use the oxygen saturation feature with this oximeter. If the first, second, or both readings do not coincide, make sure to slide the finger all the way into the oximeter sensor. If the reading still does not coincide, the feature was not properly calibrated. Go back to step one and repeat the procedure.

For information on troubleshooting this feature, refer to the troubleshooting guide in the Appendix.

IV MEDICATION INFUSION (OPTIONAL)

This feature allows you to calibrate the IV medication infusion for the drug recognition module. The system is calibrated from the factory. Re-calibrate only if necessary.
To calibrate, follow the steps below:

1. Turn on the simulator.
2. Locate the drug recognition kit and attach the drain hose to the black output port. Place the end of the drain tube inside a container lower than the arm in order to siphon the fluids in the next steps.
3. Next, attach a pre-filled syringe with clean water to the white port.
4. Insert water in the system until fluids flow through the drainage hose into the container. The fluid drained must flow in a downward direction.

**WARNING**

You must always have water in the IV vasculature for the drug recognition module to work.

5. Go to the Setup menu and click on Calibration.
6. The Calibration dialog box is displayed. Select IV Medication Infusion and click "Next".
7. Select the arm to calibrate and click next. The calibration information box is a reminder that the IV vasculature must be filled with fluid before continuing.
8. Follow the instructions and insert 20 ml of fluids in the forearm using the fill syringe.

9. The value in the middle of the window will begin to update as you slowly insert the fluid. After inserting 20 mL, click "OK".
10. The word “Done” will flash in the middle of the window, and the oval will fill green temporarily.
11. After a few seconds, the “Finish” button will be enabled and the oval will default back to gray.
12. Click “Finish” to save the new calibration.

**FACTORY SETTINGS**

Factory Settings is a very useful tool to consider when recalibrating. It restores the sensors to factory settings over-riding any calibrations performed by users.

Make sure that when you are restoring the sensors to the factory settings that no one is practicing chest compressions, ventilations, intubation or reading a blood pressure. Any of these actions may interfere with the reset. Each time that one of these sensors is clicked a message will appear at the bottom left of the screen notifying the user of the status of the reset (OK, or TRY AGAIN). Should the Sensor not respond, please refer to...
At the end of calibrating a function, the Calibration Wizard resets the simulator for the changes to take effect and displays the message “Done”. If the wizard displays the message “Can’t reset”, it simply means that the new calibration values will take effect next time you start the software. If the changes need to take immediate effect, simply close the UNI software, wait about one minute (for the simulator to turn off), and then start UNI again.

**OPTIONS**

Navigate through the Options menu to configure software settings and enable additional features.

**ENVIRONMENT**

The environment tab is used to configure the connectivity options. Select the ‘GENERIC’ option to scan and connect to the nearest simulator. Alternatively, select the FIXED option and enter the simulator’s serial number to connect to a specific simulator only. A drop-down menu will display a list of previous serial numbers entered.

The FIXED mode is required to enter activation code for upgrade features.

Use the “Layout Customization” option to customize the UNI software layout.

**GENERAL**

This tab allows the facilitator to:
• Enable auto saving of the log
• Save your current log report
• Reset the session timer and send scenario description to the Virtual Monitor every time a scenario is started

Now the “Alice1” vitals will be load as default every time the simulator is started.

Notice that this feature is profile specific, so it will only apply for the profile in question.

SIMULATOR ADD-ONS

Activation codes enable upgrade and additional software features.

• Automatic Mode – Enter the Automatic Mode activation code to enable the automatic operating mode option in the profile menu.

Add-ons will vary according to each simulator

PACING/SHOCK

UNI can detect small variations in the heart rate and current during pacing. Each variation could trigger a programmed auto response or create a new entry in the log event. Adjust the threshold for each parameter so only the changes greater than the ones specified will be detected by the UNI software.
TOLERANCES

Use the Tolerances to adjust the maximum cyanosis level.

LOG

Log event text entries are color-coded. Use the log tab to customize the color of each log entry type. Also, select or deselect “Log CPR” to have CPR recorded in the Log window.

OTHER

Checkmark “Details Apply: clear and close details window” to show the value of each palette’s vital signs parameter on the Details tab control fields.

Checkmark “Link respiration sensor to EKG leads sensors” to generate artifacts with each compression.

CPR OPTIONS

Configure the CPR trainer parameters to meet the most current CPR standards.

- Set the number of compressions per minute
- Set number of ventilations per minute
- Set average of compression depth
- Set average of ventilation PIP (peak inspiratory pressure)
Checkmark “Use AV system other than Kb Port” to display the audio and video configuration menu on the menu tab.

**NOELLE FEATURES**

- **Pulse Strength** - Adjust the pulse strength control to fine tune the pulse intensity felt at a normal blood pressure.
- **Labor Force Display** - Set the low, medium, high threshold values displayed on the “labor force” display.
- **Reset labor motor** - Click “Reset Labor Motor” to recalibrate the motor’s starting position on the track. Remove the fetus from the abdomen before calibrating the motor.
- **Fetal Monitor Paper Speed** - Select from the speeds to adjust the fetal monitor paper centimeter to minute ratio displayed on the virtual monitor screen.

**NEONATE FEATURES**

Customize the following simulator specific features:

- Fine-tune the pulse intensity for normal blood pressure.
- Synchronize the leg blood pressure to the arm blood pressure when the values are not specified.
- Synchronize post-ductal and pre ductal oxygen saturation parameters when values are not specified.
- Use temperature sensor

**REMOTE ACCESS VIA NETWORK**

The “Remote Access via Network” feature allows UNI to communicate with the simulator remotely using the virtual monitor PC as the RF transmitter.
The alternate configuration may provide better connectivity in environments with numerous walls or obstructions between the simulator and the control PC.

The USB RF module drivers must be installed on the virtual monitor PC before the “Remote Access via Network” feature can be configured.

Go to www.Gaumard.com to download the latest USB RF module drivers using PC with internet access. Do not connect the Virtual Monitor PC to the internet. Transfer the USB RF module setup file to the virtual monitor PC using a USB drive and complete the installation.

To configure the “Remote Access via Network” connection:
1. Connect the simulator’s USB RF module an available USB port on the virtual monitor PC
2. Verify that both computers are connected to the ad-hoc network (e.g. GaumardNet.)
3. Initialize UNI on the tablet PC open the Remote Access via Network menu from the Setup menu
4. Select the Remote access via network radio button
5. Verify that Wireless Network Connection is selected from the adapter list
6. Click “Find available” to auto configure the port used for this connection
7. Write down the controller IP and port number, then click “Connect”
8. Navigate to the V menu on the virtual monitor computer and select “Remote access Via Network”

Please wait 30 seconds for the feature to initialize
9. Enter the “controller IP” and “port number” as shown on step 7 and click “connect”

AUTO RESPONSES

The Non-Scenario Automatic Response feature allows the facilitator to set preprogrammed responses to electrical therapy events. When the electrical therapy is detected, auto-responses can automatically load a specific palette item or prompt the facilitator before making preprogrammed changes to the simulator’s vital signs.

Non-scenario response settings detect electrical therapy administered when a scenario is not in progress. For information on how to configure auto-responses for use during a scenario, go to Scenarios section. To activate the virtual shock panel for administering electrical therapy virtually, go to Menu>Options>General.

- The behavior of each auto response option is explained below:
  - Off - The software does not respond to the electric therapy
  - Prompt - The software detects the electrical therapy and prompts the facilitator before applying the changes configured in the “Settings” section.
  - Auto - The software automatically detects the electrical therapy and compares it to a threshold selected by the provider. If the threshold is met, the vitals will automatically change to the parameters specified on the “Settings” section.

Each type of electrical therapy has a unique set of default parameters. For example, the default response to a defibrillation Shock applies the following vital sign parameter changes: NSR, 75 bpm, BP 120/80. Click the palette button.
to program a specific palette item as an auto-response.

AUTOMATIC MODE NON-SCENARIO
AUTOMATIC RESPONSES

The “Automatic Mode non-scenario Automatic Responses” are unique to the automatic mode.

Link All Auto Response to Cardiac Irritability - Auto-responses will work only if the cardiac irritability option on the details page matches the selection on this window.

An event prompt is displayed if electrical therapy is detected and the cardiac irritability set does not match the selection on the responses window.

Drug Model Effect – Configure the auto-response behavior for drug administration.
- Auto – Apply the drug effects based on medication's programmed properties and dosage
- Prompt – Display a confirm prompt before applying the drug's effects

SET MED ID

For Instructions to program the tagged syringes with a medication type and a concentration, refer to the “Medication tab” subsection above.

SCAN RF CHANNELS

Use the Scan RF Channel tool to search for the strongest RF communication channel available.

Click the “Scan RF Channels” option in the setup menu to start the scan. Please wait while the system completes the process.
Some sensors, such as NIBP and Thermometer feature a STAT control that will allow the facilitator to activate readings on the virtual monitors from the controller software.

**SENSOR CONTROL WINDOW**

The sensor control window is a floating panel with on/off toggle controls. Click Monitors> Sensors> Window to open the floating sensor control panel.

Move the slider to enable or disable the sensors displayed on the virtual monitor screen. The sensor will show up as ON or OFF. In the example above, all the sensors are ON except the thermometer.

Use the audio icons to enable the sensors audio on/off on the Virtual Vital Signs Monitor.

**MONITORS**

Use the Monitors drop down menu to enable/disable sensors on the virtual monitor screen, share files, program custom scalars, and verify the connection between the UNI and Gaumard Virtual Monitor software.

If the “Monitors” drop down is not showing, go to Setup>Options> Add-ons, and checkmark “Use Virtual Vital Signs Monitor.”

**SENSORS**

Use the sensors option to enable or disable any of the waveforms displayed in the vital signs monitor. Select the waveform and click “ON” to display the readings on the virtual monitor screen. To disable a parameter reading, click “OFF”. The vital signs monitor sensors defaults to “All On.”

The tallest bar represents the strongest channel. Double click the bar to connect to the simulator using the channel selected.
CUSTOM NUMBERS

Use the custom numbers feature to add custom numerical parameters to the Gaumard Monitors screen. For example, glucose levels or platelets count.

On the UNI menu bar click Monitors>Custom Numbers to open the “Custom Numerical Parameters on Monitor” menu.

Type the name, minimum value, maximum value, initial value and units of the new parameter.

Check the box “Use Decimal Point” if the custom number to be created requires it.

Then click “Add”.

The scalar parameter is now created. The user can either enter a value for the parameter and click the update icon, or modify the value from the STATUS/DETAILS control.

The scalar entry is now a blank field.

The custom numbers saved on this list will be load automatically every time the UNI software is started.

On the virtual monitor screen, click on a scalar’s menu and select “Close” to make the entry available for the custom parameter.
Click on the empty scalar menu and select “Other” from the list of available scalar parameters. Select the name of the custom parameter.

The figure below shows two new values: Glucose level and hematocrit levels. Return to the custom parameter menu on the UNI software to update the values when necessary.

The physiological model will factor weight as it performs calculations and adjusts vital responses.

CONFIGURATION

On the UNI menu bar, click Monitors> Configuration to open the “Virtual Monitor Setup” window. Use the setup window to verify the connection between the UNI software and the Gaumard Monitors vital signs software, re-configure the communication ports, and view the controller name. To troubleshoot connectivity issues between the two computers, please refer to the Appendix section.

AUTO MODE (OPTIONAL)

The “Auto Mode” drop down menu in the top left corner of the UNI contains four options: Modeling

Patients, Import Between Patients, Modeling State, Auto Log Settings, and Reset Model.

MODELING PATIENTS

This option allows you to create a new patient or load an already existing one. Pre-loaded models are found on the “Quick Start Simulator Modeling” profile.

1. To create a new patient, go to Auto Mode, Modeling Patient, new patient. Enter the name of the patient, age, gender, height, weight and/or additional notes, then click “Save”.

The physiological model will factor weight as it performs calculations and adjusts vital responses.
2. To load an already existing patient, go to Auto Mode, Modeling Patient, Load Patient.

3. Select the patient name that contains the items to be imported into the active patient.

4. Select the items to import from the list and click “Import”.

IMPORT BETWEEN PATIENTS

Use the “Import between patients” menu to import palettes, scenarios, and branching scenarios from other patient profiles into the current active one.

To import an item another patient into the active patient:
1. Click Auto Mode> Import Patient to open the “Import” menu
2. Select the item category to import

MODELING STATE

The Modeling State is like a snapshot of the physiologic model in the auto mode. “Modeling State” drop down menu under “Auto Mode” includes: Save Current State, Load State, Set
Initial State for Current Patient, and Reset Initial State.

![Image of Auto Log Settings]

**AUTO LOG SETTINGS**

This menu option is used to specify various vitals that you would like to be logged automatically after reaching a specific threshold.

![Image of Auto Log Settings]

**RESET MODEL**

Clicking on Reset Model under the Auto Mode drop down menu, will restore all vitals and physiologic controls to normal state. For instance, if the ECG rhythm is currently on Ventricular Fibrillation, clicking on reset model changes the ECG rhythm back to sinus.

**VIEW**

Modify UNI's modular interface design to accommodate specific simulations or exercises.

For example, a facilitator may prefer to just view certain detail windows, panels and tabs related to scenarios building in order to program scenarios efficiently. Outlined below are the options for customizing the UNI layout.

![Image of Interface Layout]

**INTERFACE LAYOUT**

The interface layout refers to the size, position and type of panels and tabs in the UNI environment.

To save the current state of your new patient, click Auto Mode> Modeling State> Save Current State. Then enter the state name and click OK.

To load this state saved previously, select Auto Mode> Modeling State> Load State.

Additionally, this current state can set as the initial state for the current patient. Then every time you reset this patient, it is going to have settings of this specific state.

To erase this initial state, go to Auto Mode> Modeling State> Reset Initial State.
DEFAULT INTERFACE LAYOUT OPTIONS

Change quickly between built-in interface layouts using the View>Interface Layout.

CLASSIC

Select the Classic option to revert the layout to the original state built in to UNI.

SCENARIO VIEW

The scenario view layout option only includes tabs and panels useful when working with scenario exercises.

SCENARIO EDITOR

The Scenario Editor includes panels and tabs necessary when building new scenarios.

CPR

The CPR layout allows the facilitator to monitor vital signs and the CPR trainer as the student performs exercises.

CREATING A CUSTOM LAYOUT

To accommodate a specific workflow, edit the size, position and type of panels and tabs in the UNI environment.

SIZE

To adjust the size of a panel, tap-n-hold between the panel seams, then move the cursor to the desired panel size.

POSITION

1. First, tap and hold the panel’s title tab or title bar and drag the cursor away to separate the panel from the interface.
2. A floating panel window is another position that may assist facilitators in that undocked panels are always visible on top of the user interface.
3. To dock a floating panel, drag the title bar to any of the docking position icons.
4. To create a tabbed panel, select the middle position icon.

TYPE

First, close the unused panels by clicking on the x located on the panel’s title bar.

Then, add the desired panel by tapping the menu sidebar icon located on the right.

SAVE

Select “Save” to store the custom layout. Enter a description and click OK.

LOAD

Select Load to access and load any of the layouts previously saved.

SET AS DEFAULT

Use the “Set as default” option to automatically load the current interface layout upon startup.

STATUS LAYOUT

The second layout option is used to modify and store the status/details panel elements. This refers to the model view, detail window positions and parameters.

BASIC

Select the Basic option to view common detail window controls.
To facilitate respiratory exercises, select the pulmonary layout.

**CARDIOVASCULAR**

Select the Cardiovascular status/details layout to view only parameters relating to cardiac and circulation.

**ALL**

To view all the detail windows and parameters available, select ALL. If viewing all the controls, it is recommended to expand the size of the status/details panel so the details windows can fit.

**SAVE**

Select Save to store the custom status layout. Enter a description and click OK.

**LOAD**

Select Load to access any of the status layouts previously saved.

**SET AS DEFAULT**

Use the “Set as default” option to automatically load the current status layout upon startup.

**A/V (AUDIO & VIDEO)**

UNI is capable of interfacing with a number of third-party A/V recording systems. Generally, A/V solutions capture footage of the simulation and interlace it with the event information generated by the simulator control software.

To enable the fetal Neo link menu option, go to Set Up > Options > Other and checkmark “Use AV System”.

**FETAL NEO LINK (AUTO MODE)**

The “Fetal Neo Link” transfers the fetal vital signs to the Newborn/Premie Software at end of the delivery. The feature allows the providers to continue simulation using the full featured neonate without interruptions.

**HAL FETAL NEO LINK SETUP**

To configure the fetal link communication between the HAL and Newborn/Premie computers:

1. Click F/N Link > Setup FN open the Fetal Neo Link connection menu

2. Set the adapter to “Wireless network connection

3. Enter a port number for the connection and click “Connect”. If the port number is busy, click “Find Available” to scan for an open port.

Newborn HAL / Preemie Fetal Neo Link Setup

Click “Setup AV” to configure the software connection to the AV system. Enter a port number for the connection and click “Connect” to establish a link. Please contact the AV administrator for information on how to accept incoming connections from the UNI software.
4. Open the “Setup F/N” menu on Newborn HAL /Premie HAL tablet.
5. Enter the HAL controller IP and the matching port number and then click “Connect”.

The Fetal Neo Link is now connected. For information on troubleshooting connectivity issues, please reference the Appendix.

**USING THE NEO LINK**

The fetus vital signs information is transferred at the end of the delivery automatically. Alternatively, click “Transfer current fetal data” to send the information manually.

A prompt is displayed on the Newborn HAL /Premie software to accept the incoming neonatal vital information. Click “Yes” to load the vital signs information.

**HELP**

**CHECK FOR UPDATES**

Redistributable UNI installer files are available for download at http://www.gaumard.com/software-updates/.

To update the UNI software using a flash drive:
1. Download the update file to a flash drive using a computer with internet access
2. Copy the setup file to the simulator’s control computer
3. Run the UNI update file to update the software

To update the UNI software using an Ethernet connection:
1. Connect an Ethernet cable to the laptop PC.
2. Click “Check for Updates”.
3. Click “Install” to begin the update. The download progress bar begins to auto-fill as the setup file is downloaded

After the download is complete, the update setup wizard is launched automatically.
EKG Designer

Use the EKG designer to create a custom 12-lead rhythm. Click the EKG designer button to open the EKG designer window.

After a rhythm is created and saved, navigate to the designer tab to load the custom rhythm.

EDITING AND CREATING 12 LEAD RHYTHMS USING THE EKG DESIGNER

EKG designer starts with a set of flat lines in all waveforms. From this point, new rhythms can be created, or existing rhythms from the UNI library can be edited and saved as new waveforms. Rhythms drawn in the EKG Designer are assumed to be at 60 beats per minute, with any morphology changes as a result of lower or higher rates being automatically handled by the software.

To edit an existing rhythm, select it from the Cardiac Rhythms list on the top right hand side of the EKG Designer window. New rhythms can be created by simply adding and manipulating points on the default flat lines of the EKG Designer window.

Once a rhythm is loaded, it can be edited by clicking and dragging the dots on waveforms II, III and V1-V6. In the precordial leads, the dots lie on a green line which shows the waveform generated at the site, while the waveform detected at the patient monitor is shown as a thin black line.

Dots can be added by right clicking on the waveform line, or on the green line for leads V1 through V6. The Preview button in EKG designer hides the editing dots to provide an uncluttered image of the working rhythm.

Note that because waveforms I, aVR, aVI and aVf are dependent on lead II, they cannot be edited directly.

HEART SOUNDS TIMING

In order to properly time the heart sounds in custom rhythms, it is necessary that the user identify points P, R and T within the Lead II...
waveform. These points are colored Blue, Red and Purple, respectively.

In order to identify points P, R and T, right click over the desired point and select the appropriate letter.

VARIABLE SEGMENT

A variable segment identifies the line between two points that can be extended and reduced as the heart rate decreases and increases. If present, this segment needs to be identified on all lead waveforms.

CONTROL PANEL

To save a customized rhythm, enter a name in the Save textbox on the right side of the window and click on the Save icon.

Rhythms included as part of UNI Module’s EKG library cannot be deleted; however, they can be edited. Modified rhythms can be applied directly from the “Designer” tab of the Rhythm Selection window on the Details tab. Changes made to default rhythms can also be rolled back by selecting the desired rhythm and clicking on the Restore button of the EKG Designer window.

EDITING CONTROLS

The Link Points controls can be used to drag sets of points left or right without modifying an existing drawing. This function can be useful to align waveform features (such as QRS complexes) across several lead waveforms.

The Atrial and Ventricular Contraction Efficiency values are used by UNI’s Automatic Mode to determine parameters such as blood pressure and oxygenation.

The Beep on R value informs the Gaumard Virtual Monitors (if available) that an EKG beep should occur at the point designated as the R on the Lead II waveform.
Myocardial Infarction Editor (HAL Only)

Use the Myocardial infarction editor to create custom myocardial infarctions using an interactive model of the heart. The EKG generated displaying the effects of the MI can be loaded into the simulator so it can be detected using a real EKG monitor.

To access the editor, click on the MI icon located on the side menu bar inside the EKG Designer.

HEART VIEWER

To rotate the heart, click and hold the stylus button, then rotate the heart to the desired position. The zoom control and the reset rotation button are located on the right of the heart view window.

MI CONTROLS

Located on the left panel are the MI controls. These tools are used for creating myocardial ischemia, injury and necrosis.

- **Load**
  - Use the load button to access built in MI models or access previously saved items.

- **Save**
  - After the MI model is created, click Save to store the new preset to the system.

- **Reset**
  - The reset MI model button resets all the settings to a healthy state.

- **Save Image**
  - Save MI image in the computer files

ADD OCCLUSION POINT

Begin by clicking on the add occlusion point button on the menu. To auto generate MI from an occlusion, select any of the following options: Ischemia, injury and necrosis. The size of each MI type is adjusted by using the slider controls located on the right panel. After the occlusion point properties are set, click the location on...
the artery where the occlusion point will be generated.

MI PAINT BRUSH
Click on the Paint Brush button to create MI using the modified brush tool.

ERASE
Begin by selecting the type of injury that will be erased, then use the modified cursor to delete the injury from the model.

DELETE OCCLUSION POINT
Click on the “delete occlusion point” button and select the green occlusion on the heart viewer using the modified cursor. Deleting an occlusion will also remove any MI that was previously generated.

TIME PROGRESSION
Click on the time progression button to convert the MI or select the secondary control to adjust
the age of the infarction. To apply the change, click Process.

The new custom heart rhythm will be available as an option in the EKG physiological parameter control. Once the heart rhythm is selected, it can be incorporated into a palette or applied immediately.

SAVE AS IMAGE

Choose Save Image to store a snapshot of the EKG. When prompted, select a location to save the image.

PREVIEW EKG

Use the preview button to display the EKG onscreen with an additional 2 leads or a preview with RV + PW.

12 LEAD

Click 12 lead and select two full length leads to display in addition to the 12-leads.

SAVE EKG

Click the Save EKG button to display the following options.

SAVE AS EKG

Choose “Save to Library” then enter a name for the new rhythm in the “Save as EKG” window and click OK.

Click OK to display the preview window.
Labor (Noelle Only)

The Labor tab is used to program, play, and monitor a labor and delivery scenario. Reference this section to learn more about the programmable features available on the Labor tab. To carry out a labor and delivery simulation exercise, please reference the “Working with NOELLE” directions for use section.

1. Load/save Labor - Click “Load” to select from the preprogrammed labor scenarios.
2. Labor scenario information - Displays the patient name/scenario name and the patient history.
3. Labor duration - The simulated duration of the delivery; from stage one to stage three.
4. Labor progress line - The vertical line moves to the right indicating the progress of the labor scenario.
5. Descent curve - The programmable descent rate of the fetal head relative to the ischial spine
6. Descent station - The position or level of the fetal head relative to the ischial spines
7. Palette time line - Holds palette items in respect to when they occur during the delivery
8. Palette Item - A preprogrammed set of vital signs parameters or speech.
9. Initial Fetal Position - Select the fetus position (ROA, LOA, ROP, LOP) that matches the position of the fetus inside the abdomen.
10. Remote positioning controls - Click the turn controls to rotate the fetus inside the abdomen.
11. Disable Rotation - Turn off the fetus internal and external rotation automatically.
12. Shoulder Dystocia - Turn the dystocia feature on or off and set the station when turtle signs begin show.
13. Check ROT/LOT delivery - Verifies the fetal shoulders are positioned ROT/LOT before disengaging automatically
14. Contraction Descent - Advance the delivery mechanism only during contractions
15. Contraction response - Generate speech responses with every contraction.
16. Smart labor - Run labor palette items for the time specified regardless of the speed increase.
17. Manual release - Click the release button to disengage the baby from the motor arm
18. Play/Pause - Click play to start the scenario and activate the delivery mechanism
19. Labor speed - Adjust the labor speed to simulate the labor scenario in a fraction of the time. For example, increase the speed to complete a 30-minute labor scenario in 2 minutes.
20. Reset - Reset the motor back to the starting position at the end of the delivery
LABOR SCENARIOS

Preprogrammed labor scenarios are included in the “Quick Start NOELLE and "NOELLE Advanced" profiles. To load a labor scenario, go to the labor tab and click the “Load Labor” button.

The “Load Labor Scenario...” menu is displayed. Scroll through the list of labor scenarios available. Every preprogrammed scenario includes a scenario description. Select a labor scenario and click “Load” to continue.

LABOR DURATION

The labor duration refers to the simulated duration of the labor scenario from beginning to end.

The approximate duration of the labor in real time is displayed near the labor speed slider.

The system can complete a lengthy labor scenario in a fraction of the time. Use the slider to increase the labor progress speed. In this example, the entire 30-minute labor scenario will be completed in approximately 2 minutes (real time).

INITIAL POSITION SYNCHRONIZATION

The birthing mechanism simulates internal and external rotations from any of four initial positions: ROA, LOA, LOP and ROP. Each of the position’s rotation routine is preprogrammed to result in the vertical delivery of the fetal shoulders (ROT/LOT).

During the delivery setup process, adjust the position of the fetus in the abdomen to one of the four initial positions. Then, on the Labor tab, select the initial position option that matches the fetus in the abdomen. See the figure below for an example of the four initial positions with the matching option selected on the Labor tab.

A mismatch between the initial position of the fetus in the abdomen and the position selected in the software will result in incorrect internal and external rotations. When the initial position is not synchronized, the fetal shoulders may deliver horizontally; adding strain to the birth canal material.
INTERNAL AND EXTERNAL ROTATIONS

Each initial position is preprogrammed with an internal rotation and the external rotation routine. See an example of the direction of each rotation in the figure below. The red curves illustrate the rotation of the fetus within the abdomen. The internal rotation is marked as “1” and the external rotation marked as “2”.

DISABLE ROTATION

The “disable rotation” option turns off the fetal rotation. The fetus can still be rotated remotely using the rotation controls.

REMOTE POSITIONING CONTROLS

Click the turn controls to rotate the fetus inside the abdomen as shown below.

EDITING ROTATIONS

The start and end of each rotation routine can be customized to simulate a specific rotation behavior. Click the “Edit” button to view and edit the rotation configuration for each initial position.

The start and end of each rotation routine is configured using the “Station” menu. On the figure below, the internal rotation is programmed to start when the progress line intersects the descent curve at station ~5 and end when it
crosses station −0.8; use the slider to change to end of the internal rotation. The external rotation is programmed to occur later in the descent starting at station +2.3 and ending at +5.5; use the slider to change the start and end of the external rotation.

LABOR GRAPH

The labor graph displays the information required to monitor the movement of the fetus during delivery. The graph is also interactive.

DESCRIPTIVE STATION

The numerical values in the horizontal axis represent the labor station. These measurements are an approximation.

DESCRIPTIVE CURVE

The descent curve represents the position of the fetal head relative to the ischial spines in centimeters, from −5 cm to +10 cm (station). “Right-click” on the line and add a point where the descent rate should change.

There are configurable presets for all four initial positions. Click the “Apply” button to save the changes. Customized values remain saved even after a software restart. Click cancer to abort the changes selected. Click “Reset” to return all Stations and rotation degrees to factory defaults.
Tap and hold the point and move it to adjust the descent curve.

Add more points on the line to simulate variations in the descent rate.

To delete a point from the line, right-click over the point and select "remove point".

The add palette item window is displayed. Select a palette item to change the patient's vital signs, a preprogrammed speech item, or a file. Set the transition time and then click “Add”.

Once the point has been added, you can touch it with the stylus and drag it to the desired location on the timeline. Double-click over the point to bring up a window displaying the properties of the Palette Item represented by the point.

To remove or edit a palette item from the timeline, right-click over the point and select the desired option.

---

**PALETTE TIME LINE**

The timeline is where Palette Items are placed to change the patient's vital signs during the scenario. As the progress line moves to the right, it loads every palette item it passes over. To add a palette item to the timeline, right-click on the timeline and select "Add Palette".
LABOR CONTROLS

Use the labor controls to run, pause, speed up, and reset the labor scenario.

The “Play” button starts the labor scenario and initializes the delivery mechanism. The play button is also used to pause the scenario. Reference the “Working with Noelle” section for step-by-step walkthrough on how to complete a labor scenario.

WARNING

Do not start the labor scenario until reading “Working with NOELLE” and the “Care and Cautions” sections of this guide. Damage caused by improper use is not covered under warranty.

Use the Labor Speed slider to adjust the labor speed without affecting the simulated labor duration. For example, increase the speed to complete the simulation of a 30-minute labor in 2 minutes real time.

The “Reset” button returns the delivery mechanism to the starting position after the delivery is completed.

WARNING

Do not reset the delivery mechanism while the fetus is still attached to the motor arm. Retracting the fetus into the birth canal may result in damage to the birth canal and the fetus.

PROGRESS LINE

The vertical progress line moves to the right when the labor scenario is started. The progress line intersects the descent curve and the time line. Palette items placed on the time line are triggered when the progress line passes over them.

LOCKING MECHANISM AND RELEASE

The birthing mechanism arm attaches and locks into the fetus attachment port. The motor arm low voltage cable feeds power to the locking mechanism and fetal heart tones speaker inside the fetus. There is one actuation of the locking mechanism when the articulating baby is inserted.

The fetus is unlocked from the birthing mechanism when the vertical progress bar reaches the end of the graph. The automatic unlock process is indicated by the “Releasing…” status on the software a final push.

WARNING

Guide the baby out of the birth canal by gently pulling in line with the birthing mechanism. Pulling the baby upward or downward in contrast to the birthing mechanism’s linear trajectory, may bend the motor arm and cause damage to the birthing mechanism.

The fetus will not be unlocked automatically if the “Shoulder Dystocia” feature is activated. If the Shoulder dystocia feature is active, click the...
“Release baby” button to disengage the fetus manually.

The locking mechanism features an automatic safety release to prevent users from damaging the system. Go to the appendix to troubleshoot issues related to the unlocking and releasing process.

**ADDITIONAL LABOR FEATURES**

The additional behavior options add realism to the labor scenario.

**SHOULDER DYSTOCIA**

Enable the shoulder dystocia feature to display the retraction of the fetal head during the delivery. Turtle signs are displayed with every contraction that occurs after the progress line passes the dystocia station. The shoulder dystocia behavior occurs in real time regardless of the speed increase.

In the Cynthia labor scenario, the shoulder dystocia is programmed to start at station 9. There will be a turtle sign with every contraction occurring after station 9 at 24 minutes, until the end of the delivery at the 30-minute mark. Recall that the contraction frequency is programmed into the palette items set on the palette item line.

Always adjust the descent curve or the station, so the delivery mechanism has time to simulate the turtle signs. In addition, configure the descent curve so there is ample time during the dystocia for several contractions. In the figure below, the shoulder dystocia feature is active but the descent curve never passes the shoulder dystocia station. The configuration will not result in visible turtle signs.

**CHECK ROT/LOT DELIVERY**

This option Verifies the fetal shoulders are positioned ROT/LOT before disengaging automatically.

In the Cynthia labor scenario, the shoulder dystocia is programmed to start at station 9. There will be a turtle sign with every contraction occurring after station 9 at 24 minutes, until the end of the delivery at the 30-minute mark. Recall that the contraction frequency is programmed into the palette items set on the palette item line.
CONTRACTION DESCENT

Check mark the “Contraction descent” option so the delivery mechanism descends only during contractions.

CONTRACTION RESPONSE

The contraction response option generates changes to the maternal vital signs or speech on every contraction automatically. The contraction response feature simulates patients treated with or without pain medications. When the feature is active, vital signs parameters increase for the duration of the contraction only. The maternal vital signs adjust back to the previous vital signs setting at the end of the contraction.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Speech</th>
<th>Speech/vitals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maternal Vital Signs Changes</td>
<td>No Changes</td>
<td>Increase HR, BP, and RR</td>
</tr>
<tr>
<td>Audio Palettes</td>
<td>“I think I’m having contractions”</td>
<td>“Ouch,” “Ahh,” “Please, I need something for the pain,” “Please give me an epidural.”</td>
</tr>
<tr>
<td>Notes</td>
<td>Simulates a patient that is pain-controlled</td>
<td>Simulates a patient that is NOT pain-controlled</td>
</tr>
</tbody>
</table>

SMART LABOR

The smart labor option adjusts the labor speed so all the non-speech palettes occur in real time. Set the timer to configure the number of seconds each new palette should play in real time. The labor will resume to the adjusted labor speed after the smart labor time expires.

FETAL MONITOR

UNI displays feedback data recorded by the delivery mechanism sensors. Manipulating the fetus during the delivery prompts the “Activity on Fetus” window to appear on the tablet screen. The window provides feedback on pull force, uterine contractions, torque on the baby (twisting force), and shoulder position.

The labor activity information can assist in determining if the participant is applying too much pull force during the delivery. The information displayed should only be used as reference. The instructor must provide the information on proper technique to the participant.

- Uterine Activity - contractions generated by NOELLE.
- Peak Force - approximate measurement of how hard the provider is pulling the fetus.
- Slider - Rewind the strip to see the previous graph data.

Labor Speed - Use the labor speed slider to increase the labor progress speed.

This labor speed is synchronized with the labor speed option from the “Labor” page.

SAVE LABOR

Click the “Save Labor” button to store the current labor configuration and options as a new scenario.
The “Save Labor Scenario...” window is displayed. Type in Patient’s name and the patient information in the blank fields and click Save.
Modeling (Pediatric/Newborn/Premie)

Use the Hypoxia tab to evaluate the effectiveness of provider intervention on an apneic patient. The model adjusts the cardiac, oxygen saturation, and cyanosis dynamically in response to effective ventilations. The model also responds to the administration of epinephrine and oxygen.

**HYPOXIA MODEL STATE**

The hypoxia model options improve or deteriorate the cardiac and respiratory vital signs gradually.

- **Pause** - Model will pause at the current state.
- **Improve** - Trend the vital signs to a healthy state.
- **Deteriorate** - Trend the vital signs to a severe cyanotic state. Ventilations are detected when the respiratory rate is at 0.

**CYANOSIS LEVELS**

Select the cyanosis level to move to any of the following states immediately:

- **Healthy** - Pedi is pink with adequate oxygenation.
- **Mild Cyanosis** - Pedi is slightly blue, and the vital signs are starting to deteriorate.
- **Severe Cyanosis** - Pedi is blue, apneic, and vital signs are rapidly worsening.

**MODELED THERAPY**

The modeled therapy menu provides additional intervention options.

- **Improve Gain** - Adjust the slider to increase or decrease the cyanotic response to ventilations.
- **Oxygen** - Adjust the slider to administer oxygen to the fetus in liters per minute.
- **Epinephrine** - Administer epinephrine to the model. Set the epinephrine dose and then click “add”. Administering epinephrine increases the heart rate.
- **Reset** - Click “Reset” to clear the oxygen flow and the epinephrine dose onboard.
NewroSim™

NewroSim™ is a dynamic tool that includes scenarios that simulate both head injuries and stroke when using the HAL family (S3201, S3101, S3000, and S3040.100) of Gaumard’s tetherless patient simulators.

NewroSim™ interacts with UNI software allowing caregivers to diagnose and treat a variety of neurologic scenarios such as head injury or stroke.

INITIATING NEWROSIM™

To enable this application inside UNI software, navigate to the Menu>Setup>Options>HAL Add-ons and enter the activation code provided for the specific simulator’s serial number.

NEWROSIM™ PROFILE

Once the application is enabled, a NewroSim™ profile will be available.
A message window will show up while the NewroSim™ instructor interface establishes connection with the NewroSim™ Monitor.

Notice that the NewroSim™ connection icon will indicate the connection status by changing from red (not connected) to green (connected).

Once the NewroSim™ connection is established, the NewroSim™ Monitor will appear in a separated window.
To apply any palette from the list, highlight it and select the “Apply” icon.

Additionally, palettes can be modified or deleted. To modify a palette, highlight it from the list and click on the “Properties” icon. The “Properties” window will appear and the user can change the settings inside the palette as shown below.

Then click the “Modify” icon to save the changes. To delete palettes, use the “Delete” icon.

CEREBROVASCULAR MODEL

The cerebrovascular model allows the user to generate occlusion at different levels of the cerebrovascular system.
This control decreases the autoregulation in order to simulate old patients or patients with impaired autoregulation such as victims of head trauma.

To change the autoregulation percentage, place the cursor over the “Autoregulation” control and make click to select from 0-100 % in 25% increments.

CO2 reactivity is the cerebral autoregulation governed by chemoreceptors. This refers to the physiological mechanisms that maintain the blood flow at an appropriate level during changes in arterial CO2 partial pressure.

This control allows instructor to impair CO2 reactivity to simulate patients with various pathologies.

To change the CO2 reactivity percentage, place the cursor over the “CO2 Reactivity” control and click to select from 0-100 % in 25% increments.
SAVING CHANGES AS A PALETTE

To save the changes applied to the cerebrovascular model as a palette, click Save and enter a name for this palette.

Now the new palette is available under the palettes menu.

To apply or modify this palette, refer to the "NewroSim™ Palettes" section above.

MONITOR CONTROL

The monitor control allows the instructor to send the current palette from the NewroSim™ control to the monitor.

To activate the traces on the NewroSim™ monitor so they match the selected palette, turn on the Active Trace sensor as shown below.

Then select a trace from the drop down menu.

Select “Apply Settings” to see the desired trace on the NewroSim™ monitor.

Use the Reset control to reset the patient condition to default.
Use the Stop control to freeze the trace on the monitor.

NEWROSIM™ CREDITS

Click on NewroSim™ button to get information about this application.
Appendix
Scenarios Planning

THINKING IN TERMS OF PALETTE ITEMS

As described previously, palette items represent complete or partial groups of settings that have been stored as a single item. Applying partial states will hold constant all settings that are left unspecified.

Not only does it take time to customize the palette, but a very large palette becomes difficult to navigate. So, it is desirable to minimize the number of Palette Items in each Profile. To accomplish this, an experienced facilitator tries to create items that are as generally applicable as possible and can therefore be applied to a wide range of scenarios. The key is to include only in your palette items the settings that are directly related to the physiological event represented by that palette item.

SMART SCENARIOS

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to build a scenario. You may have already tried building your own or modifying some of the factory presets. The following four guidelines will refine your ability to build the best possible scenarios.

1. How will the scenario begin?

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this condition. Make sure that this first step in the scenario is a complete state. That is, indicate some selection for each available setting on the Details page. Remember that only the settings you specify will cause a change in NOELLE, and all other settings will remain constant. Therefore, by starting with a complete state, NOELLE’s condition will always be the same when the scenario starts, regardless of what she was doing previously.

Likewise, the “transition duration” of the first step in the scenario should be zero, indicating that changes are applied immediately.

There is one point that can cause confusion and warrants further explanation. It is an extension of the above discussion of partial states. The issue is best illustrated through the following example:

Suppose that you are creating a Palette Item to start your scenario. In this case, you have decided that the patient will be apneic. The question is, “How should the lung sounds be set?”

Most people’s first inclination is to set the lung sounds to “none.” This is incorrect, despite apnea. Obviously, no lung sounds should be heard during apnea, but since you have already set respiratory rate to zero, none will be. (Sounds are synchronized to the breathing cycle.)

What you are really setting here when you choose a lung sound is the condition of the lungs, given respiratory drive. That is, if the patient’s respiratory rate were changed from zero, what sound would be heard? Assuming that the lungs themselves are normal in this scenario, you would choose “normal” for the lung sound setting.

Then, as the scenario progresses, if the patient starts breathing, there will be no need to set the lung sound again. It will already be set. The same principle applies to the heart sound and other settings.

2. Include notes to guide the facilitator during the simulation.

It is common for scenario designers, especially those who act as facilitators, to neglect the importance of notes in the scenario. They think that they will remember the learning objectives, patient history, and other details at the time they are ready to conduct the simulation. They usually do not, especially when revisiting a scenario months after creating it.

When you add “Wait” and “Wait Indefinitely” steps to a scenario, you have an opportunity to edit the item description. Use this description field to hold notes to the facilitator. Typically, scenario designers write notes in that space to indicate what the provider(s) or facilitator should be doing at that point.

Further, when saving the scenario, you may edit the scenario description. This is the best place to put patient history and any other longer notes and instructions.
3. Assume that providers will do the right thing. Usually a scenario should be created with the assumption that the providers will perform correctly. As long as they do, the scenario can be allowed to continue.

Naturally, preparation must be made for what might happen to NOELLE when providers deviate from expectations. The consequences of such deviations can sometimes be included in the scenario, punctuated by “Wait Indefinitely” items. In other cases, the simulation will require more direct control by the facilitator via either the Palette or Details page.

4. Choose auto-response settings based on the scenario content and the objectives.

As seen, auto-responses can be used to free the facilitators’ attention. They also enhance realism by presenting instant reactions to the care providers. On the other hand, sometimes it is not possible or desirable to determine the responses before the simulation begins. Different environments and applications call for different settings.

Some teaching practices are best done with the auto-response settings in Prompt mode. Responses must be triggered by a vigilant facilitator. Though it is slower and requires more attention, the benefit of Prompt over other modes is that the simulation can be allowed to go in any direction, and it will be possible to choose the response on a case-by-case basis.

Other learning exercises require a higher degree of automation. For such applications, most facilitators choose Auto mode for the auto-response settings. The key issue is standardized timing of symptom presentation. A consistent, repeatable simulation is essential for fair assessment of that care provider in relation to others and for the broader interpretation of results in the context of training validation studies.

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control of the responses as events are detected.
Pro+ System Offline Updater
(If Applicable)

INSTRUCTIONS FOR USE

1. Head to www.Gaumard.com
2. Click the Software Updates button located on the middle right, under the slideshow.
3. Select the Pro+ button from the software download. Scroll down until you reach the Pro+ download section.

4. Select Download Update to download the Pro+ update file.

5. Plug a USB Drive that is greater than 2GB into your Windows computer.
6. Locate the downloaded file and place onto the root of the USB (Not in any folders)

7. Remove USB device from your PC and plug into the ETC Pro+/micro+ computer.

8. Unplug the network cable from the ETC Computer.

9. Start up the ETC laptop and click the Update System Icon.
10. Wait for the update screen to arrive.

11. Click Update (Update may last about an hour)

12. Reboot ETC after a successful update.

13. Plug in the network cable and the off-line update procedure is completed.
Wireless Ad-Hoc Network (Without USB Router)

UNI generates the vital signs information displayed on the virtual monitor PC. The information is transmitted through a wireless ad-hoc connection between the two computers in real time.

The wireless settings are configured at the factory, so no additional configuration is required.

Use the “Create an ad-hoc Wireless network” tool to configure the wireless ad-hoc link between the two computers. Then, configure the connection between UNI and the Gaumard Monitors software.

UNI NETWORK CONFIGURATION

Complete the next steps using the “Controller - Create Ad-Hoc Wireless Network” tool built in to UNI software.

1. From the menu bar, go to Help > “Create ad-hoc Wireless Network”

The “Controller - Create Ad-hoc Wireless Network” window is displayed.

2. Click “Clear previous network settings”

3. Select the “Wireless Network Adapter”. If the wireless adapter is not listed, first enable the adapter using the Windows® network menu and then return to this window.

4. Enter a wireless network name (case sensitive). Use the same wireless network name to configure the Gaumard Monitors PC. “GaumardNet” is the required name for Windows® 7 computers.

5. Click “Set Dynamic IP” to set the wireless network dynamic.
6. Click “Apply Wireless Network Settings” to save the settings.

7. Exit the UNI software.

8. In the case of Windows 7 computers, Navigate to Wireless Network Connection icon the right lower corner of the desktop to select “Open Network and Sharing Center”.

9. Select “Manage Wireless Networks” and make sure that only GaumardNet is listed as shown below.

10. Restart the computer.

Notice that steps 6 and 9 only applies for a Windows 7 computer.

1. On the virtual monitor computer, click the Gaumard Monitors icon to start the vital signs software.

2. Click the V menu near the top left corner and select “Create Ad-Hoc Network”.

The “Virtual Monitor - Create ad-hoc Wireless Network” window is displayed.

3. Select “Wireless Network Adapter”. If the wireless adapter is not listed, first enable the adapter using the Windows® network menu and then return to this window.

4. Enter a wireless network name (case sensitive). Use the same name entered in
the controller computer. “GaumardNet” is the required name for Windows® 7 computers.

5. Click “Set Dynamic IP” to set the wireless network dynamic.

6. Click “Apply Wireless Network Settings” to save the settings.

7. Restart the computer.

CONFIGURE THE VITAL SIGNS BROADCAST

After the wireless ad-hoc link is established between both computers, complete next steps to configure the transmission of the vital signs information.

1. Verify that both computers are connected to the GaumardNet network using Windows® wireless connection menu. If the computers are not connected, select the “GaumardNet” network and click “Connect” manually.

2. Start the UNI control software.

3. On the UNI menu bar, click Monitors> Configuration.

The “Virtual Monitor Setup” window is displayed.
4. Set the adapter to “Wireless network connection”
5. Verify the network status and network name, then click “Connect” to begin transmitting the vital signs information.
6. Write down the “Controller Name” and “Port number”.
7. Start the Gaumard Monitors software on the virtual monitor PC.
8. Click the “V” menu near the top left corner, and then select “Comm Setup”.
   The “TCP Comm Setup” window is displayed.

9. Enter the “Controller name” and “Port number” displayed on the UNI “Virtual Monitor Setup” window.
10. Click “Connect” to accept the incoming connection.

To connect both computers using a local internet network, follow the steps below:

1. Verify that both computers have applied “Set Wireless Network Dynamic”. Refer to UNI and Gaumard Monitors network configuration sections for instructions.
2. Disconnect both computers to the GaumardNet network and connect them to the local network manually using Windows® wireless connection menu.

3. Repeat the same steps listed above to connect the UNI software to the Gaumard Monitors software.
Wireless Network with USB Router

USB ROUTER SETUP

These first steps of the instructions will apply to customers receiving the router as an upgrade. If you received the Gaumard Monitor computer with the router already attached, please proceed to step number 4:

1. Add Velcro to USB router and VM
2. Connect Router to USB power supply (Computer can be packaged with router connected)
3. Open the Wireless Network Connection on the Monitor Computer and connect to the default network, which name will be
   \((\text{GaumardSimulatorSerialNumber})\)
   \((\text{i.e. example})\)  GaumardB0000001
4. Open the Wireless Network Connection on the simulator control computer and connect to the same network name (GaumardB0000001)

CONFIGURE THE VITAL SIGNS BROADCAST

Complete next steps to configure the transmission of the vital signs information, after the wireless connection is established between both computers.

1. Verify that both computers are connected to the GaumardB00000001 network using Windows® wireless connection menu. If the computers are not connected, select the network name and click “Connect” manually.
2. Start the UNI control software on the control computer.
3. On the UNI menu bar, click Monitors> Configuration.
   The “simulator Virtual Monitor Setup” window is displayed now.
4. Set the adapter to “Wireless network connection”
5. Verify the network status and network name, and then click “Connect” to begin transmitting the vital signs information.
6. Verify that the IP Type is set to automatic, if not From the menu bar, go to Help> “Create ad-hoc Wireless Network”
   The “Controller - Create Ad-hoc Wireless Network” window is displayed
11. Enter the controller name from the UNI software and verify the port number

12. Click “Connect” to accept the incoming connection

Microphone Boost for Streaming Audio

Use the instructions below to increase the streaming audio volume. The Headset must be connected to the tablet in order to adjust the microphone volume properties. In addition, adjust the recording control on the headset’s physical control to high.

1. Right click on the speaker icon located on the bottom right corner of the laptop’s taskbar.
2. The speaker menu is displayed. Click on the recording devices option.
3. The sound properties window and recording tab are displayed. Right-click the microphone option and select properties.
4. From the microphone properties sub menu, select the Levels tab. Use the microphone control to decrease and increase the recording volume. For an additional increase in recording volume, use the microphone boost control.

Microphone boost increases volume and saturation which can decrease overall clarity. For optimal clarity, adjust the microphone volume to 100 and the microphone boost to +10.

5. Click OK to save the changes to the volumes on the microphone properties menu.
6. Click OK to close the Sound properties window.
7. It might be necessary to re-adjust the microphone settings to accommodate environment noise.
Warranty

EXCLUSIVE ONE-YEAR LIMITED WARRANTY

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at Gaumard’s option, repair or replace the Gaumard product.

- This limited warranty covers all defects in material and workmanship in the Gaumard product, except:
  - Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product;
  - Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard product instructions, including failure to properly clean the Gaumard product; and
  - Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard or a Gaumard representative.

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special, incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and exclusions may not apply and the first purchaser may have other legal rights.

This limited warranty applies only to the first purchaser of the product and is not transferable. Any subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply.

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited warranty does not apply to any products provided along with the Gaumard product that are manufactured by third parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors (standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the warranty, if any, provided by the third-party.

- Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard.
- In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must:
  - Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard product to Gaumard without prior authorization.
  - Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL, 33196-5691 USA.

If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling, and related costs for sending the product to Gaumard and for sending the product back to the first purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be liable for all repair costs in addition to costs of shipping and handling.

Extended Warranty In addition to the standard one year of coverage, the following support plans are available: Two-Year Extension (covers second and third years)

Call for pricing (USA only)

Tips on Creating Scenarios
Contact Us

E-mail Technical Support: support@gaumard.com
Before contacting Tech Support you must:
1. Have the simulator’s Serial Number
2. Be next to the simulator if troubleshooting is needed.

E-mail Sales and Customer Service: sales@gaumard.com

Phone: Toll-free in the USA: (800) 882-6655
Worldwide: 01 (305) 971-3790

Fax: (305) 667-6085

Post: Gaumard Scientific
14700 SW 136 Street
Miami, FL 33196-5691
USA

Office hours: Monday-Friday, 8:30am - 4:30pm EST (GMT-5, -4 Summer Time)

General Information
Gaumard®, ZOE®, Michelle®, Mike®, PEDI®, Susie Simon®, Susie®, Simon® Code Blue®, SIMA Models®, SIMA GYN/AID®, Virtual Instruments®, Codemaker®, Code Blue®, NOELLE®, Simulation Made Easy™, HAL®, CPRLink™, Zack™, RITA™, Chloe™, Seatbelt Susie™, Krash Kids™, Premie™, UNI®, Omni®, SmartSkin™ are Trademarks of:

© Gaumard Scientific Company, 2015
All rights reserved.
Gaumard®, NOELLE®, HAL® are trademarks of Gaumard Scientific Company, Inc.
Patented; Other Patents Pending
Always dispose of this product and its components in compliance with local laws and regulations.